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MultiComm Host Help 
 

Help on using MultiComm Host is available at any time by selecting "Help Topics" from the 
"Help" menu on the main MultiComm Host window or by pressing the F1 key.  When Help is 
open, you can access the Table of Contents by clicking on the "Help Topics" button or you can 
search for a particular keyword by clicking the "Help Topics" button and then using the "Index" 
or "Find" tabs.  Many of the graphics are interactive, allowing you to click on a section of the 
graphic for more information on that feature.  For general help with Windows, click on the 
Windows Start button and select "Help".  

 

The following Help Topics on MultiComm Host are available: 

• Overview of MultiComm Host 

• Setting Up MultiComm Host  

• Starting MultiComm Host for the First Time  

• MultiComm Host Controls for VHF  

• MultiComm Host Controls for HF  

• HF Packet Session  

• Logging Programs   

• Rig Control  

• Troubleshooting  

• Technical Support  

• Windows Help  
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Overview of MultiComm Host 
 

For Windows 95, Windows  98, Windows NT, and Windows 2000 

 

MultiComm Host is a 32-bit MFJ Host Mode based Terminal program.  Host Mode allows the 
TNC to communicate with computer software that is more sophisticated than standard terminal 
programs.  MultiComm Host takes advantage of true multitasking in Windows 95, Windows 98, 
Windows Me, Windows NT, and Windows 2000 and uses standard Windows commands for ease 
of use.  It allows for multiple streams on multiple ports using VHF Packet and HF Non-Packet 
modes. You can use a second packet-only modem or AGW Packet Engine with MultiComm Host.  
HF modes include CW, RTTY, DSP-RTTY, ASCII, AMTOR, PACTOR, NAVTEX, FEC, 
PSK31, and Listen AMTOR.  Features of MultiComm Host include: 

 

q Multi-stream multi-port.  Up to 26 
streams per packet port, each in a 
different window 

q User-defined colors and fonts 

q Switch between streams with a click 
on the mouse 

q Supports PSK31 using your TNC for 
keying 

q A separate window for non-packet HF 
modes, from CW through NAVTEX, 
with mode selection at the click of a 
mouse 

q Interoperability with Log Windows 
and Dx4Win. 

q Basic Radio Control  q Supports COM1 to COM35 

q User defined macros q Supports two TNCs  

q Text and binary file transfers with 
YAPP.  YAPP is a file transfer 
protocol that allows you to send binary 
files via the TNC. 

q Saves QSOs (contacts made with 
another station) to a file that is 
compatible with Microsoft Word 

 

MultiComm Host will support all MFJ TNCs with the BLP protocols.  For MultiComm Host to 
run on your system you will need Windows 95, Windows 98, Windows Me, Windows NT 4.0, or 
Windows 2000.   

 

If you are not familiar with Windows and need more information on it, check your Windows 
Help, accessible from the Windows Start menu.  If you need more information on your TNC, 
consult your MFJ TNC Owners Manual. 
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Installation of MultiComm Host 
 

If you received a CD: 

1. Insert the CD into your CD drive, and wait for the AutoRun program to start. 

2. Follow the instructions on the screen to install MultiComm Host. 

 

If you received diskettes: 

1) Place disk one in drive A:  (or drive B: depending on your system) 

2) Click on the Start button to begin   

3) Click on the Run option 

4) Type   “ A:\setup.exe” (or “B:\setup.exe”) and press the OK button.  This will begin the 
installation of MultiComm Host 

            

5) Follow the directions for the setup.  It will prompt you for information you need to complete 
installation. 

6) After installation is complete, double click on the MultiComm Host icon to begin the 
program. 

7) You will be prompted to enter your Call Sign and the Serial Number and Activation Key you 
received on registering your software.  You are able to register up to 10 different call signs.  
You will also need to select the registration set.  The registration set is used if more than one 
Call Sign is used.  To select which registration set to use, click on the left and right arrow 
keys.  You will need to enter your Call Sign, Serial Number and an Activation Key to access 
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the full capabilities of MultiComm Host.  NOTE:  Activation key is  case sensitive.  

  

If you don’t have a Serial Number and Activation Key, you will still be able to run the program 
but only in Demo Mode.  Demo Mode allows you to operate packet only using single port, 
multi-stream without any of the advanced features of the program.  Click on the Demo Mode 
button to continue. 

8) You will be prompted to enter your computer’s COM port and baud rate for the TNC.  This 
allows you set which COM port your TNC is using and the baud rate.  MultiComm Host 
supports COM1 through COM35.  Make sure your TNC is connected to the COM port that 
you choose and make sure you choose a baud rate that is the same as the baud set in your 
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TNC.  

9) Now you are ready to begin using MultiComm Host for Windows. 
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Register Software 
 

You are able to register up to 10 different call signs for family members in the same household.  
You will also need to select the registration set.  The registration set is used if more than one call 
sign is used with the program.  To select which registration set to use, click on the left and right 
arrow keys.  You will need to enter your Call Sign, Serial Number, and an Activation Key to 
access the full capabilities of MultiComm Host.  NOTE:  Activation key is  case sensitive.  Each 
call sign will need its own activation key. 
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Starting MultiComm Host the First Time 
 

If this is your first time using packet radio, you might want to try connecting to your own 
Mailbox first.  After installation of the program and TNC has been completed, you can start 
MultiComm Host in a few different ways:  

 

q By double clicking on the desktop icon .  

q By clicking on the Start menu .  Select Programs and then click on the MultiComm 
Host Icon.  

q By using Windows Explorer.  For more information on this, consult Windows Help.  

 
q After the program comes up, the first item you will be greeted with is  a dialog box that 

prompts you for your Call Sign, Serial Number, and Activation Key. 

 

If you downloaded this program from the web, you will not have an Activation Key or Serial 
Number until you purchase the registered version of this program.  Just enter your call sign and 
click the Demo Mode button.  If you have an Activation Key and a Serial Number, enter them 
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and click the OK button.  The program will then ask for the COM port where the TNC is 
connected and the baud rate to use to communicate with the TNC.  The baud rate should be the 
same as the baud rate set in the TNC. The program should now come up.  If it doesn’t, check 
information in the Troubleshooting section of this manual.  

 

Now that you have finished entering the basic information, it’s time to begin the program.  On 
opening MultiComm Host for the first time you will see a large program window near the top of 
your monitor.  Near the bottom of the program window you will see a small chat buffer (the 
default color of this window is white), and a larger receive text buffer at the top (the default color 
of this window is blue).  The bar that separates the two windows is the splitter bar, it can be 
moved up and down to resize the windows to your preference.  NOTE:  When making a packet 
connection, text you receive will appear in the text buffer.  Commands and text you enter will 
appear in the chat buffer.  All results of the commands or text entered by you will appear in the 
Command Window.  The Monitor Window monitors the traffic on the packet radio port. 
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How to Report Bugs 
 

We would appreciate feedback from you.  If you find a problem with the software that you think 
may be a bug, please let us know.  You can reach us at bugs@cssincorp.com. 
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Window Commands 
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Windows Commands 
 

MultiComm Host uses a standard 32-bit Windows interface.  For general information and help 
about using Windows, see your Windows Help accessible from the Windows Start Menu.  
Windows Commands covered here that are specific to MultiComm Host include the following: 

• Open File  

• Close  

• Save  

• Save As  

• Print  

• Print Preview  

• Print Dialog Box  

• Print Preview Toolbar  

• Print Setup  

• Cut  

• Copy  

• Paste  

• Cascade  

• Tile  

• Arrange Icons  

• About Box  

• Exit  

• Status Bar  

• Toolbar  
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Help Topics 
 

MultiComm Host Help is your online help.  Help can be accessed from the “Help” menu, by 
pressing F1, by clicking the Help button on some dialog boxes, or by clicking the Help button on 

the Toolbar  and then clicking the item where more help is needed.  

 

Shortcuts 

 

     Toolbar:    

     Keys:  F1 
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Open File Command 
 

Use this command to open a document with WordPad.  

 

Shortcuts 

Toolbar:  

Keys: CTRL+O 
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Close Command 
 

Use the File, Close command to close the current session.  You can also close a session by using 
the Close button on the document's window, as shown below: 

 

Shortcuts 

     Button:   

     Keys:  ALT+F and then C 
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Save Command 
 

Use this command to save the current active session.  When you save a document, MultiComm 
Host displays the “Save as” dialog box so you can name your document.    

 

Shortcuts 

Toolbar:  

Keys: CTRL+S 
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Save As Command 
 

Use this command to save and name the active session.  MultiComm Host displays the “Save as” 
dialog box so you can name your document.  It can be saved in Rich Text Format (.RTF) or Text 
Format (.TXT) format. 
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Print  
 

Use this command to print a session.  This command presents a Print dialog box where you may 
specify the range of pages to be printed, the number of copies, the destination printer, and other 
printer setup options. 

 

Shortcuts 

Toolbar:  

Keys: CTRL+P 

 



 24 

Print Preview 
 

Use this command to display the active session as it would appear when printed.  When you 
choose this command, the main window will be replaced with a print preview window in which 
one or two pages will be displayed in their printed format.  The print preview toolbar offers you 
options to view either one or two pages at a time; move back and forth through the document; 
zoom in and out of pages; and initiate a print job. 
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Print Dialog Box 
 

The following options allow you to specify how the document should be printed: 

Printer 

This is the active printer and printer connection.  Choose the Setup option to change the printer 
and printer connection. 

Setup 

Displays a Print Setup dialog box, so you can select a printer and printer connection. 

Print Range 

Specify the pages you want to print: 

All Prints the entire document. 

Selection Prints the currently selected text. 

Pages Prints the range of pages you specify in the From and To boxes. 

Copies 

Specify the number of copies you want to print for the above page range. 

Collate Copies 

Prints copies in page number order, instead of separated multiple copies of each page. 

Print Quality 

Select the quality of the printing.  Generally, lower quality printing takes less time to produce. 
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Print Progress Dialog 
 

The Printing dialog box is shown during the time that MultiComm Host is sending output to the 
printer.  The page number indicates the progress of the printing. 

 

To abort printing, click the Cancel button. 
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Print Preview Toolbar 
 

The print preview toolbar offers you the following options: 

Print 

Bring up the print dialog box, to start a print job. 

Next Page 

Preview the next printed page. 

Prev Page 

Preview the previous printed page. 

One Page / Two Page 

Preview one or two printed pages at a time. 

Zoom In 

Take a closer look at the printed page. 

Zoom Out 

Take a larger look at the printed page. 

Close 

Return from print preview to the editing window. 
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Print Setup 
 

The following options allow you to select the destination printer and its connection. 

Printer 

Select the printer you want to use.  Choose the Default Printer; or choose the Specific Printer 
option and select one of the current installed printers shown in the box.  You install printers and 
configure ports using the Windows Control Panel.  

Orientation 

Choose Portrait or Landscape. 

Paper Size 

Select the size of paper that the document is to be printed on. 

Paper Source 

Some printers offer multiple trays for different paper sources.  Specify the tray here. 

Options 

Displays a dialog box where you can make additional choices about printing, specific to the type 
of printer you have selected. 

Network... 

Choose this button to connect to a network location, assigning it a new drive letter. 
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Cut Command 
 

Use this  command to remove the currently selected data from the session and put it on the 
clipboard.  This command is unavailable if there is no data currently selected.  You cannot cut 
data from the (blue) receive text window because this is a read-only window.  You can cut text 
from the (white) chat window.  NOTE:  These are the default color and can be change by the 
user. 

 

Cutting data to the clipboard replaces the contents previously stored there. 

 

Shortcuts 

Toolbar:  

Keys: CTRL+X 
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Copy Command 
 

Use this command to copy selected data onto the clipboard.  This command is unavailable if 
there is no data currently selected. 

 

Copying data to the clipboard replaces the contents previously stored there. 

 

Shortcuts 

Toolbar:  

Keys: CTRL+C 

 



 31 

Paste Command 
 

Use this command to insert a copy of the clipboard contents at the insertion point.  This 
command is unavailable if the clipboard is empty. 

 

Shortcuts 

Toolbar:  

Keys: CTRL+V 
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Cascade Command 
 

Use this command to arrange multiple opened windows in an overlapped fashion.  
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Tile Command 
 

Use this command to arrange multiple opened windows in a non-overlapped fashion. 
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Arrange Icons 
 

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.  If there is an open document window at the bottom of the main window, then some or 
all of the icons may not be visible because they will be underneath this document window. 
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About Box 
 

The About Box tells you who licensed the software, the model of MFJ TNC being used, and the 
version of firmware in the TNC.  To access the About Box, click on the Help menu on the main 
MultiComm Host window and then select “About MultiComm Host”.  You can also access the 

About Box by clicking on the About button on the Toolbar  . 
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Exit 
 

From the Packet window, the Exit command quits and shuts down the program.  If you have any 
open windows (connected to a packet station) they will not be disconnected when you exit .  You 
will need to disconnect before exiting from the HF window; Exit will close the active HF window 
and will disconnect.   

 

Clicking on the File menu and selecting “Exit” accesses the Exit command.  You can also Exit 
MultiComm Host by clicking on the Close button in the upper right hand corner of the HF window 

or main MultiComm Host window . 

  

Shortcuts: 

     Button:   

     Keys:  ALT+F then X 
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Status Bar 
 

VHF Status Bar 

 

                  A.                                                             B.                               C. 

  D.     E.        F.     G.            
H. 

 

 

The status bar is displayed at the bottom of the MultiComm Host window.  To display or hide the 
status bar, use the Status Bar command in the View menu. 

 

The following is a description of each part of the status bar: 

 A. Emulates the TNC cmd: Converse Mode by pressing F2.  

 B. Shows which Port and Stream the session is using. 

 C. Connection status. 

 D. Press F1 for Help. 

 E. Lists the current Mode, Host or Terminal. 

 F. Local time 

 G. UTC (GMT) 

 H. Free bytes in the TNC’s buffer. 

 

HF Non-Packet Status Bar 

 

        C                                                      A                                       B 
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A.  Shows which Non Packet mode your are using. 

B.  Additional information about that mode. 

C.  TNC status. 
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Toolbar 
 

This is the VHF Toolbar: 

 

  

 

This is the HF Toolbar. 

 

The toolbar is displayed across the top of the application window, below the menu bar.  The 
toolbar provides quick mouse access to many tools used in MultiComm Host. 

 

To hide or dis play the Toolbar, choose Toolbar from the View menu (keyboard shortcut is <Alt-
V> and then <T>). 

 

 

 Click To 

             Open a new session. 

 

  Open an existing document.  MultiComm Host displays the Open dialog box, 
in which you can locate and open the desired file. 

 

  Save the active session with its current name.  If you have not named the 
document, MultiComm Host displays the Save As dialog box. 

 

  Print the active session. 
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  Remove selected data from the session and stores it on the clipboard. 

 

  Copy the selection to the clipboard. 

 

  Insert the contents of the clipboard at the text cursor. 
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General Information 



 42 

Connecting to your own Mailbox 
 

Due to the nature of the MFJ Firmware, BLP (host) mode cannot be used simultaneously with 
the mailbox.   
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Understanding the HF TOR Modes 
 

To monitor AMTOR or PACTOR transmissions, you will have to enter a monitor mode.  For 
example, to listen to PACTOR link requests or a QSO in PACTOR, you would click on the 
PACTOR Listen button or choose PACTOR from the Mode menu. 

 

To break a link (finish the QSO), you would click on Disconnect in the appropriate menu to abort 
the link or quit the TOR mode.  

 

If the station you are monitoring is calling CQ and you wish to make contact, you would issue a 
link request, again with a command specific to that mode.  For example, suppose you hear W4PC 
calling CQ in PACTOR.  To link with him, you would click the Link option in the AMTOR menu, 

type in W4PC and press <Enter>.  You can also click on the Link button . 

 

If you wanted to call CQ yourself, you would enter Standby mode for AMTOR by clicking on the 

AMTOR button  on the toolbar and then click on the Transmit button , or press F4, to 
make your radio transmit.  Then type your CQ message: 

 

CQ CQ CQ DE "your Call Sign" K. 

 

You may repeat that line several times.  Then, put your controller in Standby (and return the radio 

to Receive mode), by clicking on Receive button  or pressing F5.  

 

You are now ready to take on Solar Cycle 23 and operate one of the TOR modes.  Good hunting.  

 

Information transmitted by AMTOR is specially encoded to provide a scheme of error detection.  
This coding takes the form of each character containing 4 SPACE signals and 3 MARK signals.  
The receiving station can use this 4/3 ratio to determine if the character received is "probably" 
correct.  If the received signal were to arrive with 4 MARK and 3 SPACE signals, the signal is 
obviously in error, and the receiving station could take the appropriate action.  

 

The information is transmitted in blocks of 3 characters; that is, the sending station will transmit 3 
characters and then pause for an answer from the receiving station.  The answer will consist of a 
single character, indicating that the block just sent was either received OK or that the block should 
be retransmitted. 
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AMTOR operation is possible in two basic modes.  Mode A operation is a one-on-one mode, 
enabling the receiving station to request retransmission of any characters received which contain 
errors.  This mode provides a high degree of error immunity due to the handshaking between the 
two stations involved in the communication.  This mode is commonly referred to as ARQ. 

 

Mode B operation is similar to Baudot RTTY operation, in that the signals are not error-checked 
by a specific station and no handshaking is performed.  Mode B is the mode used for calling CQ, 
or other operations, where more than one station is intended to receive the communication.  Mode 
B operation is called FEC -- Forward Error Correction.  In this mode, each character is sent twice, 
and the receiving stations will check each character for the proper 4/3 ratio.  If the first character 
received is correct, the receiving station stores it and then looks at the repeat of that character.  If it 
is also correct and it matches with the first character, it is printed.  If one of the two was correct 
and the other did not have the proper MARK/SPACE ratio, the correctly received character is 
printed.  If both characters were received incorrectly, then the ERRCHAR is printed.  If both were 
received correctly, but they don't match, the ERRCHAR is also printed. 

 

A variation of mode B operation is called SELFEC -- Selective FEC.  In this mode, the sending 
station transmits the SELCAL of the intended receiving station for a specific time interval.  
During this time, all stations that hear the signal compare the SELCAL being received with their 
own SELCAL.  If they match, then the printing of data is enabled.  Otherwise the receiving station 
returns to a standby mode and doesn't copy the signal.  In addition, when the sending station starts 
to transmit the data, it automatically inverts the MARK and SPACE tones, resulting in four 
MARKs and three SPACEs.  Other stations that tune in during the SELFEC transmission cannot 
lock to this signal. 

 

AMTOR stations are each identified with a SELCAL -- the Selective Call Sign used to identify 
this station from all others. In most other amateur communication, we think of the call sign being 
used for this purpose, but in AMTOR, the SELCAL is normally composed of the first letter of 
your call and the last three letters of your call.  Thus the SELCAL for KF4WGU would be 
KWGU.  If your call sign does not contain four letters, the standard practice is to duplicate the first 
letter of the SELCAL.  Thus W4RJ would have a SELCAL of WWRJ.  The SELCAL is used in 
both the SELFEC and ARQ modes of operation. 

 

With the implementation of the CCIR 625 recommendation for AMTOR operation, the SELCAL 
may now contain 7 characters.  This SELCAL cannot include the characters G, H, J, L, N, and W. 
The reasons for this are contained in the Consultative Committee on International Radio document 
"CCIR Recommendation 491-1" which describes a TOR station identity. 

 

AMTOR ARQ (mode A) operation requires that both stations transmit alternately.  First the 
Information Sending Station, or ISS, (the station actually sending data) sends three characters.  
This requires 210 milliseconds.  This station then enters the receive mode and it listens for the 
acknowledgment from the Information Receiving Station, or IRS.  The sending station will wait 
240 milliseconds for an acknowledge.  After this 240 millisecond delay, the sending station will 
again enter transmit and send the next (or the same) three characters. 
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Since both stations are constantly switching between receive and transmit, fast switching times are 
required for AMTOR ARQ operation.  You can adjust ADELAY to allow for the time required for 
your station to change from receive to transmit, but you should allow a small extra amount of time 
for the other station to switch from transmit to receive.  Regardless of the setting of this parameter, 
the total turn around time for one AMTOR data/ack cycle remains 450 milliseconds. 
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CW Operation 
 

The TNC will both send and receive International Morse Code.  The computer based CW operator 
can use the TNC to send "perfect" code at much higher speeds than are typical of hand sent code.  
When a computer is used to send and receive Morse Code, you can also maintain a record of your 
contacts.   

 

Before you operate CW, you must first know where the activity is.  Morse operation is permitted 
on any amateur frequency, but most often occurs in the lower 100 to 250 kHz of a band.  To enter 

CW mode, simply click on the CW button . 
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AMTOR Information 
 

AMTOR is one of three Teletype Over Radio (TOR) modes.  Operationally, AMTOR and 
PACTOR are similar.  Commands exists in each mode for monitoring (other stations), for standby 
(to receive a link request), and for initiating a link (connect).  

 

Action     Command 

To monitor AMTOR or (SITOR)  use   

To receive a linked request or    

   go to AMTOR standby to call CQ  use  

To initiate a link    use  

 

To listen to AMTOR activity or to make an AMTOR contact using MultiComm Host, start by 
opening a HF non-packet session using the pull-down File menu. 

 

AMTOR_Listen:  Once the screen is opened, click AMTOR_Listen button  on the toolbar to 
enter the Listen AMTOR (monitor) mode.  Once the TNC is set, AMTOR_Listen will appear on 
the status bar at the bottom on the HF screen (just above the task bar).  To monitor (copy other 
stations), tune your receiver (LSB for amateur operations, USB for some commercial services) 
until the MARK and SPACE tones light both ends of the TNC bar graph.  To quit 
AMTOR_Listen, simply click on another mode or close the HF window. 

 

You are set to receive a link request from another station or you may click the Link button  to 
initiate a link.  (For commercial SITOR operations, tune in the bar graph when a transmission is 
heard to see if it is a "free" signal). 

 

AMTOR:  To make an AMTOR connect, click the AMTOR button  (if not in that mode 

already) and then click the Link button .  A menu will then appear for you to enter the 
SELCAL of the station you wish to contact.  Phasing to link (connect) follows. 

 

TO BREAK THE LINK: Click the Disconnect button .  
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SENDING TO RECEIVING DATA WHILE IN AMTOR: The station that initiates the AMTOR 

link starts as the Information Sending Station (ISS) .  The station receiving a link request and 

linking starts as the Information Receiving Station (IRS) .  As ISS you may send information 
by typing text in the chat window which is immediately below the text window and above the 
status bar (to type in text, you must place your cursor in this window).  Once you have finished 
typing the text you want to send, you can press either the ISS or the IRS button to change to 
information direction  (OPTIONAL: you can also type a "+" and a "?" to cause the AMTOR link 
to change information direction.  Once you have done that, the link will sound different and your 
status bar will reflect your station as IRS.  You can capture status as ISS by once again typing "+" 
and a "?". 

 

To call CQ click the AMTOR button  .  After you are in AMTOR standby mode, click the 

Transmit button  to call CQ, then click the Receive  to return to AMTOR standby, ready 
to be linked to. 
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AMTOR Operation 
 

AMTOR has two basic modes of operation, mode A (ARQ - Automatic ReQuest for Reception) 
and mode B (FEC - Forward Error Correction). 

 

§ ARQ AMTOR is a handshaking protocol that allows only two stations to communicate in a 
near error free fashion.  You will hear a "chirp chirp" sound when you find two stations 
conversing in ARQ.  AMTOR mode A (ARQ) is perhaps the most error-free method of 
getting messages through on HF when conditions are poor. 

§ FEC AMTOR is similar to Baudot RTTY and is used to call CQ or to carry on "round 
table" contacts. 

 

NAVTEX is a form of FEC AMTOR that is used to send navigational bulletins and weather 
information primarily to ships at sea.  It has been adopted by the ARRL to send bulletins to 
amateurs. 

 

Before you can operate AMTOR, you mu st first know where the activity is.  Most AMTOR 
operation occurs on the 20-meter amateur band between 14.065 and 14.085 MHz.  AMTOR 
activity can be found on the other HF amateur bands as well and is most often located between 65 
and 90 kHz up from the bottom of the band as it is on 20 meters. 

 

 



 50 

PACTOR Operation 
 

PACTOR is a relatively new amateur data communications mode.  It was developed in Germany 
by Hans-Peter Helfert, DL6MAA, and Ulrich Strate, DF4KV.  PACTOR combines some of the 
best features of AMTOR and packet as well as providing a few new features.  PACTOR operates 
at 100 BPS or 200 BPS depending on radio conditions.  PACTOR also contains a 16 bit CRC to 
provide near error-free operation, as does packet and can also selectively use a data compression 
scheme (Huffman encoding) to increase the throughput when transmitting text.  PACTOR uses an 
8-bit word, allowing the use of the full ASCII character set. 

 

When data blocks are repeated in the case of an error, the receiving unit  can often combine the 
information in the repeated blocks to provide a good block without the need of receiving a perfect 
block.  This scheme is called memory ARQ. 

 

Like AMTOR and packet, PACTOR has two basic modes of operation, an ARQ mode (Automatic 
ReQuest for reception) and a non-linked mode used for CQ calls and round table operation. 

 

§ ARQ PACTOR is a handshaking protocol that allows two stations to communicate in a near 
error-free fashion.  When listening to an ARQ PACTOR communication, you will hear a 0.96 
second burst of data from the information sending station followed by a short burst from the 
data receiving station that is an acknowledge (ACK) or non-acknowledge (NAK).  The 
receiving station sends the NAK when the CRC indicates an error in the data block.  Like 
packet, PACTOR is MARK-SPACE polarity independent.  The PACTOR protocol alternates 
the data polarity with every transmission. 

§ The unproto (col) mode of operation is a non-linked type of operation.  It is used for round 
table operation or for calling CQ.  The unproto mode repeats the data blocks a selectable 
number of times and can use either 100 or 200 BPS.  It also uses the CRC error check. 

 

Before you can operate PACTOR, you must first know where the activity occurs.  Most PACTOR 
operation occurs on the 20-meter amateur band between 14.065 and 14.085 MHz.  PACTOR 
activity can be found on the other HF amateur bands as well and is most often located between 65 
and 90 kHz up from the bottom of the band as it is on 20 meters.  On 80 meters, most PACTOR 
will be found between 3660 and 3690 kHz.  PACTOR is not sensitive to the sideband used, but we 
recommend using LSB as in RTTY and AMTOR operating modes. 
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RTTY Operation 
 

RTTY, or Radio TeleTYpe, has been around for many years.  The five bit Baudot/Murray code 
was the basis of the Western Union Telex service and Baudot RTTY (Radio TeleTYpe) is still 
widely used on the HF amateur bands.  The RTTY character set contains the upper-case letters, the 
numbers 0-9 and some common punctuation characters.  Because RTTY has only five bits, it is 
less prone to errors than seven bit ASCII.  Your TNC provides RTTY at all the standard speeds in 
use today, including all commercial speeds up to 300 baud. 

 

Before you can operate RTTY, you mu st first know where the activity is.  Most RTTY operation 
occurs on the 20-meter amateur between 14.08 and 14.10 MHz.  RTTY activity can be found on 
the other HF amateur bands as well and is most often located between 80 and 100 kHz up from the 
bottom of the band as it is on 20 meters. 
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ASCII Operation 
 

ASCII, the American Standard Code for Information Interchange, has been around for nearly 30 
years.  ASCII is a 7-bit code and was designed to overcome the limitations of the Baudot character 
set by including both upper and lower case letters, numbers, all punctuation as well as many 
computer control codes.   Because all possible numbers, letters, and punctuation can be defined 
within this set of combinations, no LETTERS or FIGURES shift is required.  ASCII is not so 
popular on the amateur bands, but its operation is almost identical to Baudot RTTY. Transmission 
of ASCII is accomplished using FSK or AFSK as is done in Baudot RTTY. 

 

Before you can operate ASCII RTTY, you must first know where the activity is.  Most RTTY 
operation occurs on the 20-meter amateur between 14.08 and 14.10 MHz.  RTTY activity can be 
found on the other HF amateur bands as well and is most often located between 80 and 100 kHz 
up from the bottom of the band as it is on 20 meters. 
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SELCAL 
 

SELCAL is an acronym for Selective Call.  SELCAL is derived from your Call Sign.  As a 
general rule your AMTOR SELCAL consists of the first letter in your Call Sign and the last three 
letters of your Call Sign.  To change your SELCAL consult your TNC Manual. 

 

This unique character sequence contains four alphabetic characters that are derived from your call 
sign.  The TNC will automatically do this for you just by entering your amateur call sign into the 
MYSELCAL command.   

 

Because the same call sign sequences are assigned in ten districts, it is possible that your SELCAL 
could be used by another station.  If you think a station in another call district is also active on 
AMTOR and is using the same SELCAL, see the MYSELCAL command in the TNC manual for 
information on how to change your SELCAL. 
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Slow Scan TV 
 

Slow Scan TV or SSTV is a method for transmitting pictures over radio, similar to sending color 
fax.  A number of SSTV modes have been developed by amateur radio operators including various 
Scottie, Martin, Robot modes, and Wrasse modes.  SSTV uses analog modulation and can be 
sampled at any rate.  The sampling rate will determine the number of pixels per line, with higher 
sampling rates producing better detail.  In the case of MultiComm Host, the sampling rate is 
determined by the internal sampling rate in your MFJ TNC.  
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PSK31 Information 
 

PSK31 is a new mode developed by Peter Martinez, G3PLX, and is based on SLOWBPSK 
introduced by SP9VRC.  PSK31 uses Phase Shift Keying (PSK) or patterns of polarity reversals 
rather than the more traditional Frequency Shift Keying (FSK).  Data is sent at a rate of 31.25 
baud to handle typed-in text easily.  If bandwidth is approximately equal to baud rate, bandwidth 
can be set to 31 Hz and narrow CW filters used.  Information is coded in an alphabet that is similar 
to Morse code, variable length coding.  This variable length coding was developed by analyzing 
English language ASCII text files for the frequency of occurrence of each of the 128 ASCII 
characters.  The ASCII characters were then matched to binary patterns, with the most frequently 
occurring characters having the shortest binary patterns.  Each character is separated from 
neighboring characters by two consecutive 0 bits.  No character can contain more than one 
consecutive 0 bit.  Each character must begin and end with a 1.  More information on PSK31 can 
be found on the Internet at http://www.psk31.com.   

 

Audio input and output is handled by the computer's sound card rather than a TNC.  Keying is 
done using VOX, a separate keying circuit, or the keying circuit in a TNC.  The choice of how to 
key PSK31 will depend on your equipment and personal preferences.  See the PSK31 Setup 
section of this help file for information on keying alternatives for your setup. 
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PSK31 Setup 
 

Your computer's sound card, rather than the TNC, handles audio input and output.  You will need 
to create a connection between the computer's sound card and your radio, perhaps with an 
isolation circuit to protect your equipment.  Keying can be done using a VOX, a separate keying 
circuit, or the keying circuit in a TNC.  Several alternatives are available for keying PSK31, 
depending on your equipment and computer capabilities.  Listed below are some of these 
alternatives, categorized by the type of TNC you have.  Even though PSK31 does not require a 
TNC to operate, MultiComm Host requires a TNC for operation since it is primarily TNC 
software.  Where an external keying circuit is specified, you can use a keyer such as a Rig Blaster, 
home brew keyer, or other keyer with a free serial port.  If you have a multimode TNC, you can 
use the TNC's internal keying circuit.  More information on PSK31 in general can be found on the 
Internet at http://www.psk31.com. 

 

One Multimode TNC 
 

If you have a multimode TNC, you can do all of the HF modes plus PSK31.  This also adds the 
option of using the TNC's internal keying circuit in addition to using the serial port for keying.  

§ Use the TNC's internal keying circuit for keying.  No external keying circuit is needed.  

§ Use the TNC's serial port with an external keying circuit.  

§ Use a free serial port on the computer with an external keying circuit. 

 

One Multimode TNC with a Timewave DSP-
599y or DSP-599zx 
 

With the addition of a DSP-599y or DSP-599zx to a multimode TNC, you have four keying 
options.  

§ Use the DSP-599 for keying PSK31.  No external keying circuit is needed.  

§ Use the TNC's internal keying circuit for keying. No external keying circuit is needed.  

§ Use the TNC's serial port with an external keying circuit. 

§ Use a free serial port on the computer with an external keying circuit.  
 

Note that if you use DSP-599 RTTY with a multimode TNC, you will need to use the keying 
circuit in the DSP-599 rather than the keying circuit in the TNC.  This only applies to DSP-599 
RTTY, not the TNC's RTTY.  
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PSK31 Operation 
 

PSK31, or Phase Shift Keying 31 Baud, is a new digital mode that uses your sound card to 
produce audio input or output rather than your TNC.  In MultiComm Host, keying can be done by 
an external keyer or the internal keyer in a multimode TNC.  See the PSK31 Setup section of this 
help file for information on hardware setup options and requirements.  

 

Once you have set up your system for PSK31, you are ready to start PSK31.  Simply press the 

 button on the toolbar to start PSK31.  This will bring up the PSK31 Control Panel where you 
can set your sessions controls and select a signal for your QSO. 
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AGW Packet Engine Information 
 

AGW Packet Engine uses software and a computer's sound card to send and receive AX-25 
packets rather than using a traditional TNC.  AGW Packet Engine was written by SV2AGW.  
MultiComm Host version 1.5 and higher provides an interface to AGW Packet Engine.  See the 
AGW Packet Engine Setup section of this help file for information on setting up AGW Packet 
Engine and keying alternatives for your setup.  Additional information and support on AGW 
Packet Engine is available on the SV2AGW's web site at http://www.raag.org/sv2agw. 
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AGW Packet Engine Setup 
 

MultiComm Host works with AGW Packet Engine version 2000.76 and above.  Current versions 
of AGW Packet Engine are available on the AGW Packet Engine web site at 
http://www.raag.org/sv2agw.   In MultiComm Host, AGW Packet Engine would be used in place 
of a second packet-only TNC.  The primary TNC should be a single port multimode TNC.  AGW 
Packet Engine does not allow you to choose a sound card for your system.  If you have multiple 
sound cards, it will use the default sound card.  You cannot use the same sound card for both 
PSK31 and AGW Packet Engine at the same time.  If you have only one sound card, you will need 
to shut down AGW Packet Engine in order to run PSK31.  If you want to run AGW Packet Engine 
again, you will need to shut down and restart MultiComm Host.  To use AGW Packet Engine, 
download and install the AGW Packet Engine software from http://www.raag.org/sv2agw.  Start 
AGW Packet Engine and then start MultiComm Host.  

 

AGW Packet Engine requires that you have a free serial port on your computer and an external 
keying circuit.  This serial port cannot be shared with other devices.  The serial port is selected in 
the AGW Packet Engine setup rather than the MultiComm Host setup.  PSK31 and AGW Packet 
Engine cannot share the same serial port.  PSK31 will need a separate serial port and keying 
circuit if you plan to run both PSK31 and AGW Packet Engine.  The keying circuit can be a keyer 
such as a Rig Blaster, home brew keyer, or other keyer.  If you also have a DSP-599 in addition to 
a multimode TNC, the DSP-599 cannot share a serial port with AGW Packet Engine.  See the 
PSK31 Setup section of this help file for information on keying alternatives and setup 
configurations for PSK31. 

 

 

 



 61 

Call Bar, View Tabs, and Macro Bar 
 

A few new Items have been added to MultiComm Host to make it more convenient and user 
friendly. 

 

The Call Bar is where you can enter call signs for connections without having to press F2 to bring 
up the command prompt or F7 to bring up the Quick Connect screen. 

  

 

The Window Tab allows you to easily switch between open windows in MultiComm Host. Simply 
click the tab for the window that you wish to be moved to the front of the MultiComm Host 
window. 

  

 

Another addition to MultiComm Host is the MultiComm Host icon, which is placed in the system 
tray at the bottom right-hand of your screen. 

  

 

A Macro Bar has been added to MultiComm Host to automate using your Mode Macros, calling 
CQ, and sending your ID and QRT. The CQ, ID, QRT, and Mode Macros are set under File, HF 
Non-Packet Settings on the HF window.  To automatically call CQ, select the number of times 
you wish to repeat your CQ call and the Interval between calls in seconds.   Then click the CQ 

button  to transmit your CQ call.  You can also transmit your ID, QRT, or CWID once for 

each button click by click the ID button , QRT button , or the CWID button . See the 
CQ, ID and QRT Macros Settings section of this help file for more information on setting up this 

feature.   The Mode Macro buttons M1 through M10 (for example, ) allow easy access to your 
Mode Macros that are specific to each mode.  See the Edit Macro Settings section of this help file 
for more information on setting up Mode Macros.  To quickly stop sending a macro, click the Stop 

button .  

 



 62 

Right Click Menu 
 

There is a pop-up menu available in the text and chat windows by clicking the right mouse button 
in the window.  You can also access the Copy command clicking the right mouse button in the 
command window or any of the port monitor windows. 

 

This is the pop-up menu you get when you click the right mouse button in the VHF text window 
or the HF Non-Packet text window. 

  

 

This is the pop-up menu you get when you click the right mouse button in the VHF chat window. 

  

 

This is the pop-up Menu you will see when you click the right mouse button in the HF Non-Packet 
chat window. 
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Copy Macro Variable 
 

Copies the selected text to either the {name} or {call} macro variable.  To use this command, 
select text and click your right mouse button on it to bring up the pop-up mean.  Select the “Copy 
Macro Variable” menu item and the variable as shown below.   
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Log Contacts 
 

This command allows you to send a contact to your Log Windows or DXBase 2002 database.  To 
log a contact, highlight the call sign in the HF window, click the right mouse button, and select 
“Log Contact to” from the pop-up menu and then select your choice of logging programs.   

 

After you pick the logging program, a window will appear, similar to the one below, which allows 
you to complete and send the information to either DXBase 2002 or Log Windows.  For Log 
Windows, you can also go ahead and save the information.  
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MultiComm Host VHF Controls 
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VHF View 
 

This is a MultiComm Host VHF Window.  

 

  

 



 67 

Window Menu 
 

  

Cascade - Use this command to arrange multiple opened windows in 
an overlapped fashion.  

Tile – Use this command to arrange multiple opened windows in a 
non-overlapped fashion. 

Arrange Icons - Use this command to arrange the icons for 
minimized windows at the bottom of the main window.   
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Help Menu 
 

  

Help Topics – MultiComm Host Help is your online help. 

Register Software – Use this command to register your software. 

About MultiComm Host – Shows to whom the software is registered 
and what hardware and firmware is used. 
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Quick Connect 
 

Quick Connect allows you to store frequently used connections.  To create a Quick Connect, 
select the Options menu and then select “Add Quick Connect”.  To edit a previous entry, select 
“Edit Quick Connect” from the Options menu.  To delete a previous entry, select “Delete Quick 
Connect” from the Options menu.  
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Radio 1 and Radio 2 
 

Clicking the Radio 1 or Radio 2 button on the Toolbar switches between the Radio 1 and Radio 2 
connections on the TNC.  
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File Menu 
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VHF File Menu 

 

When you first start MultiComm Host, before you have started a new session, the following File 
menu will appear.  

 

  

New VHF Session – This command opens a new 
unconnected VHF stream in a new window.  

New HF Non Packet Session – This command 
opens a window that allows you to use non-packet 
HF Modes, if allowed by your TNC. 

SSTV Modes – This command a window that 
allows you to use the slow scan TV modes.  

Settings – This command provides options to select 
the CallBook you are using, to select the drive 
associated with your CD-ROM, to change your 
COM port and baud rate settings, to create macros, 
and to create startup and shutdown commands.  

Exit – The Exit command exits from the program.  

 

After you have started a new VHF session, the following File menu will appear.  

 

  

New VHF Session - This command opens a new 
unconnected VHF stream in a new window. 

New HF Non-Packet Session Command - This command 
opens a window that allows you to use non-packet HF 
Modes, if allowed by your TNC. 

Open File - Use this command to open an existing 
document. 

View ANSI file - ANSI – American National Standard 
Institute.  ANSI is an 8-bit character set of 256 characters.  
You can view or save an ANSI file with this command.   

Close – Use this command to close the active session. 

Save – Use this command to save the active session to its 
current name and directory.   

Save As – Use this command to save and name the active 
session. 

Settings - This provides options to select the CallBook you 
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are using, to select the drive associated with your CD-
ROM, to change your COM port settings and baud rate, to 
create macros, and to create startup and shutdown 
commands. 

Print – Use this command to print a session.    

Print Preview – Allows you to preview a page before 
printing. 

Print Setup – Allows you to set different parameters for 
printing. 

Exit - The Exit command exits from the program 
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VHF Session Command 

 

The New VHF Session command opens a new unconnected VHF stream in a new window.  This 
is for VHF Packet sessions only.  Select the “New VHF Session” option in the File menu. 
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HF Session Command 

 

The New HF Non-Packet Session command opens a window that allows you to use non-packet 
HF modes, if allowed by your TNC.  Select the "New HF Non-Packet Session" from the File 
menu. 
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SSTV Modes 

 

The SSTV Modes command opens a new SSTV session window if allowed by your TNC.  To 
start a new SSTV session, click on the File menu and select “SSTV Modes”.  
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View ANSI File 

 

ANSI – American National Standard Institute.  ANSI is an 8-bit character set of 256 characters. 

 

To view an ANSI file: 

1) Select “View ANSI File” from the File menu. 

1. This brings up the screen shown below. 

2. Select the folder where the file you want to view is located.   

3. Select the file you want to view and click the Open button. 

4. The ANSI file will be displayed in the window. 
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Settings Command 

 

The Settings option brings up the Settings dialog box.  This allows you to select which type of 
CallBook CD you are using and designate the drive associated with your CD-ROM, allows you 
to change your port settings and baud rate, create macros, and create and edit startup and 
shutdown commands. 

 

• CallBook Settings 

• Communications Settings  

• Edit Macros  

• Startup/Shutdown Commands  

• Edit Call Sign Exchange  

• Optional Settings  

• User Defined Macro Variables  

• Packet Parameters  

• Packet Parameters - Switches 
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CallBook Settings 

 

A CallBook is a database of Amateur Radio Call Signs.  The following dialog box allows you to 
select which CallBook CD you use.  Options include QRZ, BuckMaster, RAC (Radio Amateur 
Callbook), SAM, or none.  It also allows you to set the drive letter that corresponds to your CD-
ROM.  MultiComm Host includes a mini contact database so even if you don’t have a CallBook, 
you can keep track of your contacts. 
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Communications Settings 

 

This allows you set the COM port to which you are connected, and the baud rate used when 
communicating with the TNC.  MultiComm Host supports COM1 through COM35.  Make sure 
your TNC is properly connected to the selected COM port, and that you select the correct baud 
rate to communicate with the TNC.  (The baud rate selected should be set to the same as the 
current TNC baud rate if it has been used before with another program.) Put a check mark beside 
"Use Two TNCs" if you plan to use a second TNC for Packet only.  If you plan to use AGW 
Packet Engine as your second, packet-only TNC, put a check mark beside "Use AGW Packet 
Engine" and select a COM port and Baud rate for AGW Packet Engine.   If you have a DSP-599 
or DSP-599y, you can choose to use DSP-RTTY.  The Radio Port option allows you to set the 
Radio Port for HF and Packet.  The default is Port 1 for Packet and Port 2 for HF.   The BLP 
Host mode logging option can be used to track down a problem.  Most often this will be used by 
technical support. 
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Edit Call Sign Exchange 

 

This box allows you to edit your call sign and your contact’s call sign to be used with the Call 
Exchange hot key. 
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Edit Macros Settings 

 

A Macro is a user-defined text that is associated with a particular keystroke.  This dialog box 
allows you to create macros.  There are 10 global macros for VHF, 10 global macros for HF, and 
10 specific macros for each of the HF modes.  Pick a name for the macro and then enter the 
information in the macro text window.  (You can use <Ctrl-Enter> to insert a carriage return 
into the macro text).  You can create a macro using the user-defined macro variables as shown in 
the picture below.  The name you specify for the new macro will show up in the macro menu. 
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Macro Variables 

 

These variables can be used in the macros that you create in the Edit Macros Settings.  The macros 
can be created using variable names and when these variables change, the macro changes 
automatically.  Click each setting for a description.  There are five macro variables you can use 
that are not listed.  Three macro variables,  {date}, {time} and {utctime} are taken from your 
system clock.  The {utctime} macro variable reports Greenwich Mean Time. The other two are 
{xmit} and {rec}.  The {xmit} variable turns the Transmitter on and the {rec} variable turns the 
Transmitter off.  These two variables can only be used in HF macros. 

 

  

 

For example, if the settings were filled in with these values: 

{call} – KF4WGU 

{name} – Sydney 

{mycall} – N4GDO 
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{myname} – ricker 

{selcal} – ngdo 

{qth} – Florence, AL 

 

you could set up a macro like this: 

{call} DE {mycall} Hi there {name}, My name is {myname}, and my 
QTH is {qth}.  My Selcal is {selcal}.  The current time is {time} 
and the current date is {date}. 

 

and when the macro was invoked, it would type this to the screen: 

KF4WGU de N4GDO Hi there Sydney, My name is ricker, and my QTH 
is Florence, AL.  My Selcal is ngdo.  The current time is 
09:33:41 and the current date is Wednesday, June 17, 1998. 
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Optional Settings 

 

  

 

MAXUSERS on startup 

This section allows you to set the maximum number of users on startup.  The MAXUSERS 
command causes the TNC to allocate the memory required for the maximum number of 
simultaneous connections you wish to allow.  Each connection uses a different stream.  You will 
see an option to change MAXUSERS on each port that you have available on your TNC.  The 
highest each port can be set is 26. 

 

Sounds 

The Sound ID on Connect option allows you to turn sounds on or off.  If you choose sounds to be 
on, you can use the sounds that are included or choose your own sounds. 

To set the sounds, click on each item and enter the filename of the sound to associate with it. 
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Startup/Shutdown Commands 

 

The dialog box shown is where you can enter your own startup and shutdown commands.  These 
commands are sent to your TNC during startup and shutdown. 
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Packet Parameters 

 

This option automates setting your TNC Packet Parameters.   Clicking the "Default Parameters" 
button resets these parameters to their default settings.  Check your TNC manual for the default 
settings for these parameters and usage of these parameters. 
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Packet Parameters – Switches 

 

This option automates switching your TNC's packet parameters off or on.  Clicking the "Default 
Parameters" button resets these parameters to their default settings.  Check your TNC manual for 
the default settings for these parameters and usage of these parameters. 
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Edit Menu 
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VHF Edit Menu 

 

  

Cut - Use this command to remove the currently selected data 
from the session and put it on the clipboard 

Copy - Use this command to copy selected data onto the 
clipboard.   

Paste - Use this command to insert a copy of the clipboard 
contents at the insertion point. 

Clear Screen - Clears the text from the active text window. 

Repeat Last Text - Repeats the last text you sent.  The text 
will be put into the active chat window. 

Copy To Call Exchange – Allows you to copy your contact’s 
call into the call exchange buffer.   

Call Exchange  - Takes the call sign you have copied with 
“Copy to Call Exchange” and appends it to the information 
that was created in the settings for Call Exchange. 
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Clear Screen 

 

Clears the text from the active text window. 
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Repeat Last Text 

 

Repeats the last text you sent.  The text will be put into the active chat window. 
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Copy to Call Exchange 

 

Copy to Call Exchange allows you to copy your contact’s call sign into the call exchange buffer, 
and then use it by clicking on Call Exchange.   

 

To copy a call sign you need to highlight it and then select the Copy to Call Exchange option 
from the Edit menu or click the right mouse button on the highlighted call sign and choose 
“Copy to Call Exchange” from the pop-up menu. 
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Call Exchange 

 

Call Exchange takes the call sign you have copied with the Copy to Call Exchange and sends it 
to the chat window along with your previously stored call sign.  Call Exchange settings are 
accessed by clicking on File, Settings, and then selecting the Edit Call Sign Exchange tab. 

 

To use the call sign in your Call Exchange, select Call Exchange from the Edit menu or click 
your right mouse button and select “Call Exchange” from the pop-up menu. 
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View Menu 



 97 

VHF View Menu 

 

  

Toolbar - Use this command to display and hide the Toolbar. 

Status Bar – Use this command to display and hide the Status Bar. 

Monitor Port 1 – Use this command to display and hide the Monitor Port 
1 Window. 

Monitor Port 2 - Use this command to display and hide the Monitor Port 
2 Window. 

Commands Window - Use this command to display and hide the 
Command Window.   

(Check mark indicates it is displayed) 
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Toolbar Command 

 

Use this command to display and hide the Toolbar, which includes buttons for some of the most 
commonly used commands in MultiComm Host, such as File, Open.  A check mark appears next 
to the menu item when the Toolbar is displayed. 

 

See Toolbar for help on using the toolbar. 
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Status Bar Command 

 

Use this command to display and hide the Status Bar.  The Status Bar displays the action to be 
executed by a selected menu item or depressed toolbar button, and keyboard latch state.  A check 
mark appears next to the menu item when the Status Bar is displayed. 

 

See Status Bar for help on using the status bar. 
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Monitor Port 1 Window 

 

  

This is where network traffic for Radio Port 1 is 
viewed. 
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Monitor Port 2 Window 

 

  

This is where network traffic for Radio Port 
2 is viewed. 

  



 102 

Command Window 

 

  

This is where the commands you 
send to the TNC and the return 
value of the commands from the 
TNC are viewed. 

 

Commands to the TNC can be 
entered at the “cmd:’ Prompt 
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TNC Menu 
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VHF TNC Menu 

 

  

Connect – This command 
brings up the Connect 
window.  

Disconnect  - This 
command disconnects the 
active window from the 
currently connected station. 

Commands – Sends 
program defined commands 
to the TNC. 

Abort Quick Connect – 
Aborts a Quick Connect. 
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Connect Command 

 

There are three ways to connect to a station: 

• Press F2.  This puts you in Command mode.  At the cmd: prompt type “c Call Sign” and 
press <Enter>.  

• Press F7 or select the Connect command in the TNC menu.  That brings up the Connect to 
Station dialog box.  To use Connect you must enter the call sign of the other station and then 
click the Connect button.  

• You can also create a Quick Connect to the stations you use frequently.  This allows you to 
click on the station rather enter it every time you want to connect to it.  To create this 
shortcut, you must select “Add Quick Connect” from the Options menu on the Quick 
Connect screen. 
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Disconnect Command  

 

The Disconnect Command disconnects the active window from the currently connected station. 
There are three ways to disconnect from a station: 

• Press F2 and type “d” at the cmd: command prompt.  (Without the quotes) 

• Press <Shift-Alt-F7>. 

• Select “Disconnect” from the TNC menu. 
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Mheard Command 

 

Selecting the Mheard command returns a list of the stations heard by the TNC.  The stations 
heard response appears in the Command window.   
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Status Command 

 

Selecting the Status command will display the following information in the Command window: 
the number of bytes available in the TNC buffer, the current I/O stream, and any streams having 
connected status command.  Results of these commands will be in the Command window. 
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Version Command 

 

The Version command causes the TNC to display the current version number in the Command 
window.   
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Send Control A 

 

Some bulletin boards and clusters use the <Ctrl-A> key sequence for text editing.  Commands 
such as these are similar to the standard Windows commands, so MultiComm Host uses <Shift-
Ctrl-A> instead.   

 

Hotkey: <Shift-Ctrl-A>. 
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Send Control T 

 

Some bulletin boards and clusters use the <Ctrl-T> key sequence for text editing.  Commands 
such as these are similar to the standard Windows commands, so MultiComm Host uses <Shift-
Ctrl-T> instead.   

 

Hotkey: <Shift-Ctrl-T>.  
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Send Control Y 

 

Some bulletin boards and clusters use the <Ctrl-Y> key sequence for text editing.  Commands 
such as these are similar to the standard Windows commands so MultiComm Host uses <Shift-
Ctrl-Y> instead.   

 

Hotkey: <Shift-Ctrl-Y>. 
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Send Control Z 

 

Some bulletin boards and clusters use the <Ctrl-Z> key sequence for text editing.  Commands 
such as these are similar to the standard Windows commands, so MultiComm Host uses <Shift-
Ctrl-Z> instead.   

 

Hotkey: <Shift-Ctrl-Z>.  
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Send Command 

 

The Send command brings up a Send Command dialog box similar to the one shown below.  
This allows the user to enter a TNC command.  The results of these commands will be in the 
Command window. 
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Abort Connect 

 

When using a VHF Quick Connect, using this command will abort the Quick Connect.  This will 
not work when you use the regular Connect option. 
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Mode Menu 
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VHF Mode Menu 

 

  

Host - Host Mode operation 
provides a standardized 
method of communication 
between the MFJ TNC and 
MultiComm Host for 
Windows.   

Terminal – Terminal Mode 
operation is  a 
communication mode with 
the TNC similar to that of a 
standard (not Host Mode) 
terminal program. 

Return to Terminal Mode 
on Exit – Allows you to 
exit Host Mode and return 
to Terminal Mode when the 
program is closed. 

Unproto - Unproto Mode 
operation allows packets to 
be transmitted without 
being connected to a 
station. 

Minimize all windows 
when main window is 
minimized – Minimizes all 
open windows when you 
minimize the main 
windows.  A check mark 
indicates this command is 
enabled. 

Sync with logging 
program – Allows 
MultiComm Host to sync 
with either Log Windows or 
DX4Win.  MultiComm 
Host and either Log 
Windows or DX4Win must 
be running to use this 
command. 
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Host Mode 

 

BLP (Host) Mode operation is the normal communications mode between a MFJ TNC and 
MultiComm Host for Windows.  It allows for multi-port, multi-stream and non-packet modes in 
separate windows, at the same time. 
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Terminal Mode 

 

Terminal Mode operation is a communication mode with the TNC similar to that of the 
Windows terminal program, HyperTerminal.  All Terminal Mode functions are at the TNC level 
with the software acting as a "Dumb" terminal. 
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Return to Terminal Mode on Exit 

 

When selected, the TNC will be returned to Terminal Mode when exiting the program.  You may 
want to select this choice if you use other programs to operate the TNC, when you are not using 
MultiComm Host. 
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Unproto Mode 

 

Unproto Mode operation allows packets to be transmitted without being connected to a station.  
These packets are not directed to a specific station, therefore no acknowledge is expected and no 
retries are attempted.  This mode is often used to call CQ and for informal round table chats.  
This  can be used with either Host or Terminal Mode.  
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Minimize All Windows when Main Window is Minimized 

 

When this item is checked, the Command Window and Monitor Windows are minimized or 
maximized when the larger MultiComm Host window is minimized or maximized. 
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Sync with logging program 

 

Allows MultiComm Host to sync with either Log Windows or DX4Win.  MultiComm Host and 
either Log Windows or DX4Win must be running to use this command.  See the section on 
Logging Programs  for more information.  
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Format Menu 
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Format Menu 

 

  

Font - The Font command allows the user to select the type, style and the size of the 
font used to display text in the window. 

Color – In the Text box, the Color command allows the user to select the colors of 
the text, the transmitted text, the command text, and the background.  In the Chat 
box, the user can change the color of the chat text and the background. 
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Font Command 

 

The Font command allows the user to select the type, style, and the size of the font used to 
display text. 
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Color Command 

 

The Color command allows the user to select the color of the text and background for the text 
box, the chat box, the transmitted text box, and the Command window. 

 

  

 

Selecting any of the four-color boxes brings up the following color chart.  By selecting “Define 
Custom Colors”, you are able to choose from common colors for background or you can define 
new colors to use. 
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File Transfer Menu 
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VHF File Transfer Menu 

 

  

Send YAPP - Sends a file using the binary transfer protocol called YAPP. 

Receive YAPP – Receives a file using the binary transfer protocol called 
YAPP. 

Send ASCII - Sends an ASCII file with no protocol. 

Stop Transfer - Stops any file transfer (YAPP or ASCII). 
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Send YAPP 

 

Sends a file using the binary transfer protocol called YAPP.   

 

Send YAPP allows you to transfer a file (text, binary, picture, etc.) from your computer to 
another station.  

 

To send a file with YAPP upload, first make sure you are in the session window of the station to 
which you want to send a file.  If you are connected to a BBS, you will want to tell the BBS that 
you are doing a YAPP upload before you start your transfer.  After the other station is ready to 
receive, pick the Send YAPP option from the File Transfer menu.  A file dialog box will come 
up.  Now you can pick the file to transfer or cancel the transfer. 

 

After you pick the file, the YAPP upload will begin. Note that all the file transfer information is 
updated on the status bar for the current session.  This will let you know the progress of your file 
transfer.  You can also continue to chat with the other station while the transfer takes place. 

 

After the transfer is done, the status bar will be updated. 

 

To abort a transfer, select the 'Stop Transfer' from the menu or click the Stop button the toolbar. 
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Receive YAPP 

 

Receives a file using the binary transfer protocol called YAPP. 

 

Receive YAPP allows you to receive a file (text, binary, picture, etc.) from another station using 
the YAPP Download transfer protocol.  

 

To receive a file with YAPP Download, first make sure you are in the session window of the 
station sending you the file.  If you are connected to a BBS, you will need to start the YAPP 
transfer from the BBS before Downloading in MultiComm Host.  After the other station is ready 
to send, pick the Receive YA PP option on the menu.  A file dialog box will come up.  Now you 
can enter a file name for the transferred file or cancel the transfer. 

 

After you name the file, the YAPP download will begin. Note that all the file transfer 
information is updated on the status bar for the current session.  This will let you know the 
progress of your file transfer.  You can also continue to chat with the other station while the 
transfer takes place. 

 

When the transfer is finished, the status bar will be updated. 

 

To abort a transfer, select  'Stop Transfer' from the menu or click the Stop button on the toolbar. 
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Send ASCII 

 

Sends an ASCII text file with no protocol.  This option allows you to upload ASCII files while 
connected to another s tation.  To send an ASCII file with this option, you will be presented with 
a dialog box asking you for the filename.  Choose the filename and click the OK button.  The file 

will be transferred.  To abort the transfer, click on the Stop button  or select the “Stop 
Transfer” menu option. 
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Stop Transfer 

 

Stops any file transfer (YAPP or ASCII).  When the Stop button  is selected, any remaining 
text or data that has not been sent to the TNC is terminated.  You may see some text on the 
screen after the transfer is aborted.  This is normal due to emptying of the buffer or the TNC 
emptying. 
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Lookup Menu 
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Lookup Menu 

 

  

Call Sign – Allows the user to look up a particular call sign. 
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Call Sign Lookup Command 

 

The Call Sign Lookup command allows the user to look up a particular call sign.  You enter the 
call sign and click the “Lookup” button to look up the call sign in the CallBook specified in the 
MultiComm Host Settings.  Information about the call sign is then displayed.  Before the 
information is returned from the CD CallBook, you can enter or modify the contact information 
for that station in the MultiComm Host contact database.  
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Macros Menu 
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Macros Menu 

 

  

 

A Macro is user-defined text that is associated with a particular 
keystroke.  There are 10 global macros for VHF, 10 global macros 
for HF, and 10 specific macros for each HF mode. To create a 
macro, select the Settings option from the File menu and click on 
the Edit Macros tab to get the Edit Macro Settings page. Pick a 
name for the macro and then enter the information in the macro text 
window. 
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Macros 

 

Macros are messages that the user is able to define and assign to a keystroke.  You can create up 
to ten different global macros in both Packet and Non-Packet HF modes.  Also each of the Non-
Packet HF modes can have up to 10 mode-specific macros. 
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MultiComm Host HF Controls 



 142 

HF View 
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Link to a Station 
 

To link to another station, you need to click the Link button  in the toolbar.  You will be 
presented with a TOR Connect box where you can enter the SELCAL of your contact. 
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Disconnect from a Station 
 

To disconnect from a station, click the Disconnect button  in the toolbar. 
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Sending to Receiving Data 
 

The station that initiates the link starts as the Information Sending Station (ISS) . 

The station receiving a link request and linking starts as the Information Receiving Station (IRS) 

. 

 

As ISS you may send information by typing in the chat window which is immediately below the 
text window and above the status bar.  Once you have finished typing the text you want to send, 
you can click either the ISS or the IRS button to change the information direction.  Once you have 
done that, the link will sound different and the status bar will reflect your station as IRS. 
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Changing HF Data Transmit Mode 
 

A new feature in MultiComm Host is the HF Data Transmit Mode.  With this new option you can 
choose one of many ways to send your HF communications.  The settings are (1) Character Mode 
(2) Word Mode or (3) Line Mode. 

 

Character Mode: With this setting selected, MultiComm Host will transfer data after each 
character is entered.  For example, if you were typing in CQ CQ CQ DE N4GDO K, then 
MultiComm Host would transmit as follows: 

   

(T)=transmit Data to TNC 

C(T) Q(T) C(T) Q(T) C(T) Q(T)  D(T) E(T) N(T) 4(T) G(T) D(T) O(T) 
K(T) 

 

Word Mode: If you select this option, then MultiComm Host will transmit after every word or 
every time you press the <Space> bar or the  <Enter> key. To send a carriage return without 
transmitting data, press <Ctrl-Enter>. For example, if you were sending CQ CQ CQ DE N4GDO 
K, then it would be transmitted as follows: 

   

(T)=Transmitted data to TNC 

CQ(T) CQ(T) CQ(T) DE(T) N4GDO(T) K(T) 
 

Line Mode: When you select this option, MultiComm Host will transmit to the TNC every time 
you press the  <Enter> key. This allows you to wait until you have typed everything you wish to 
send before MultiComm Host sends the data in one big burst. To send a carriage return without 
transmitting data, press <Ctrl-Enter>.  Using the same example as above the data would be 
transmitted as follows: 

   

(T)=Transmitted data to TNC 

CQ CQ CQ DE N4GDO K. (T) 
   

In order to take advantage of this feature, simply click on Settings in the File menu. 
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After the Settings window appears on your screen, simply choose the Optional Settings tab at the 
top of the Settings window and you will see the following window: 
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When this screen appears, simply choose the mode you would like to use. 
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DSP-RTTY 
 

DSP RTTY uses the internal RTTY in a Timewave DSP-599.  RTTY is the acronym for Radio 
Teletype. 

 

To make a DSP RTTY contact you must: 

1) First Open a New HF Window from the File menu. 

2) You need to be in DSP RTTY Mode.  To check the current mode, look at the status bar. 

3) There are two ways to change modes: 

a) Select DSP RTTY from the Mode menu. 

b) Click on the DSP RTTY button  in the toolbar. 

4) Once you are in the correct mode (notice the mode in the status bar), you need to tune to the 
DSP-RTTY signal according to the specifications in your Timewave DSP-RTTY manual. 

5) When it is tuned correctly, you will start to see the RTTY characters in the text window. 

6) Now you are ready to reply or call CQ.  There are two ways to accomplish this. 

a) Type data in the chat box and press <Enter>.  Pressing <Enter> turns on the transmitter.  
It then transmits the data to the TNC and switches back to receive automatically. Use 
<Ctrl-Enter> to send a carriage return without turning on the transmitter. 

b) You can also click the Transmit button  in the toolbar and type your message in the 
chat box.  With this you send one (1) character at a time.  Then you must click the 

Receive button  to receive.  This clears the chat buffer. 

7) Now you are ready to Call CQ again or receive DSP RTTY from another station. 
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HF File Menu 
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HF File Menu 

 
This is the HF File menu 

   

 

Open File - Use this command to open an existing 
document. 

Close - Use this command to close the active 
session. 

Save  - Use this command to save the active session 
to its current name and directory.   

Save As - Use this command to save and enter 
different name for the active session. 

HF Non Packet Settings - Allows you to specify 
specific settings for the different HF Non Packet 
modes. 

Print - Use this command to print a document.    

Print Setup - Allows you to set different 
parameters for printing. 

Exit - The Exit command closes the HF window. 
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HF Non Packet Settings 

 
Below is a list of the different HF Non Packet Settings screens.   

 

• ASCII Settings  

• CW Settings  

• RTTY Settings  

• NAVTEX Settings  

• AMTOR Settings  

• PACTOR Settings  

• PSK31 Options  

• Edit Call Sign Exchange  

• User Defined Macro Variables  

• Edit Macros  

• CQ, ID and QRT Macros  
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AMTOR Settings 

 

• MYSELCAL - Sets your 4 character AMTOR SELCAL.  

• CWCALL – Sets the 15 characters that are sent as CW when you issue the ID character.   The 
CWCALL is sent following the QRA signal.  

• ALTCALL – Set a 4 letter alternate SELCAL for use in AMTOR Mode A.   

• TXDELAY – Sets the delay between the time the transmitter is keyed and the time the data is sent.  

• Use ALTCALL – Uses the alternate SELCAL set up with ALTCALL 

• Invert TX Tones – Switches the MARK and SPACE transmit tones.  This might be used, for 
example, when you are on LSB and the other station is on USB. 

• Invert RX Tones – Switches the MARK and SPACE receive tones.  This might be used, for 
example, when you are on LSB and the other station is on USB. 

• Print Mode S Transmission – Displays S Mode Transmissions that are addressed to your SELCAL.  

• Selectively Monitor Mode B – Turns MATCH On and selectively monitors Mode B FEC 
transmissions that match the strings in the MBEGIN and MEND commands 

• Underscore displayed if error – If the TNC detects an error during reception, it will display an 
underscore character ( _ ).  

• Echo After Sent – Echos text that is sent for transmission when it is sent rather than echoing text as 
you type.  

• Convert to Lower Case – Upper case characters will be translated to lower case characters.  

• Continuous Retries on Connection Fail –  The maximum number of times a packet is retransmitted 
after no acknowledgment before the transmission is aborted. 

• MATCH Text MBEGIN – A parameter up to 15 characters long that is used to print a Mode B 
transmission with the string in MBEGIN is matched.   

• MATCH Text MEND – A parameter up to 15 characters long that is used with MATCH and 
MBEGIN to stop displaying or printing a Mode B  transmission when the string in MEND is 
matched.  

• WRU (ANSBSTR) text – Who Are You text - This is personal information about yourself that is 
automatically sent by the TNC in response to a “Who Are You?”.  It can be up to 15 characters in 
length.  
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ASCII Settings 

 

• Unshift on Space – The receiver shifts to LTRS case when a SPACE character is received.  
UNSHIFT may not be compatible with stations transmitting weather information or strings of 
numeric text.  

• Diddle Character - If this item is checked, a diddle character is sent when no characters are available 
from the keyboard or buffer during transmission. 

• Add LF to sent CR - Adds an extra Line Feed when a Carriage Return is sent. 

• Mars Display - Translates LTRS characters to <Ctrl-O> and FIGS characters to <Ctrl-N> and sends 
these to the terminal. 

• Invert TX Tones - Switches the MARK and SPACE transmit tones.  This might be used, for 
example, when you are on LSB and the other station is on USB. 

• Invert RX Tones - Switches the MARK and SPACE receive tones.  This might be used, for 
example, when you are on LSB and the other station is on USB. 

• European RTTY Tones – Uses low tones that are standard in Europe for RTTY and ASCII 
operation, with a MARK of 1275 Hz, SPACE of 1445 Hz, and a frequency shift of 170 Hz.  

• Echo as Sent – Echoes text that is sent for transmission when it is sent rather than echoing text as 
you type. 

• Baud – Select the character transmission and receive speed in baud.  
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CW Settings 

 

• CW Speed – This command sets the MSPeed used when transmitting in CW Mode. 

• CW Weight – Allows you to set the weight of the CW code elements generated by the keyboard or 
key paddle.  The default is a dot-to-space ratio of 1:1.  A setting of 0 set the weight factor to the 
default.  A number from 1 to 127 increases the dot-to-space ration.  A number from 128 to 255 
decreases the dot-to-space ratio.  

• Echo As Sent – Echoes text that is sent for transmission when it is sent rather than echoing text as 
you type. 

• Auto Track Transmit Speed – Allows you to match your transmit speed to the speed on the 
incoming CW signals.  

• Auto Track Receive Speed – Allows automatic tracking of the speed of incoming CW signals.  If 
the speed of the incoming signal changes significantly, the TNC will LOCK to the new speed.  

• Farnsworth Spacing – Enables Farnsworth spacing where 15 WPM equivalent letters and elements 
are used.  
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PACTOR Settings 

 

• Auto Line Feed In – A linefeed character is added when a carriage return is received during 
PACTOR monitoring (AUTOLF). 

• Auto Line Feed Out – A linefeed character is added after a carriage return in transmitted text 
(LFADD). 

• Connect Bell – Causes a bell tone to sound when a PACTOR connection is established (CBell). 

• Changeover Bell – Causes a bell tone to sound when a PACTOR changeover occurs (CHObell). 

• Exact Call Matching – Causes the TNC to respond to connect packets that exactly match the letters 
in your callsign (EXActcal).  

• Rapid LED Flash at 200 baud – The TNC’s LEDs flash rapidly for each cycle where a 2000 baud 
packet is sent, received, or expected (LEdmode).  

• Echo characters as Sent – Echoes transmitted text after receipt of a remote acknowledgment rather 
than echoing text as you type (EAa). 

• Monitor – Enables the monitoring of all packet activity (Monitor). 

• Timeout Attempts - Sets the number of timeout attempts. 

• Unproto – Initiates 100 baud or 200 baud FEC. 

• Wait – Select the time delay between the depression of the PTT and the start of packet transmission. 

• MaxDown – Sets the maximum number of received 200 baud information packets that contain errors 
before the TNC requests a SPEEDdown to 100 baud. 

• MaxSum – Sets the number of cycles of received error-laden information packets that are 
accumulated for reconstruction.  

• MaxUp – Sets the maximum number of received error-free 100 baud information packets before the 
SPEEDUP to 200 baud is requested.  

• ID Time – Sets the time interval between automatically generated CWID events.  

• Unproto Speed – Sets the FEC baud rate. 
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RTTY Settings 

 

• Unshift On SPACE - When this option is checked, an unshift to letters can occur when a SPACE is 
received.  

• Diddle Character - If this item is checked, a diddle character is sent when no characters are available 
from the keyboard or buffer during transmission. 

• Add LF to sent CR - Adds an extra Line Feed when a Carriage Return is sent. 

• MARS Display - Translates LTRS characters to <Ctrl-O> and FIGS characters to <Ctrl-N> and 
sends these to the terminal. 

• Invert TX Tones - Switches the MARK and SPACE transmit tones.  This might be used, for 
example, when you are on LSB and the other station is on USB 

• Invert RX Tones - Switches the MARK and SPACE receive tones.  This might be used, for 
example, when you are on LSB and the other station is on USB 

• European RTTY Tones – Uses low tones that are standard in Europe for RTTY and ASCII 
operation, with a MARK of 1275 Hz, SPACE of 1445 Hz, and a frequency shift of 170 Hz. 

• Echo As Sent – Echoes text that is sent for transmission when it is sent rather than echoing text as 
you type. 

• Baud – Select the character transmission and receive speed in baud. 
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NAVTEX Settings 

 

§ NAVTEX Originating Stations - This command specifies which originating stations will be copied 
in the NAVTEX mode. 

§ NAVTEX Message Classes - This command specifies which classes of NAVTEX messages will be 
sent to the attached terminal. 
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PSK31 Options 

 

§ Keying - Choose the appropriate option for the method you will be using to key PSK31.  If you 
choose to use an external keyer on a separate serial port, you must also choose the COM port where 
the keyer is attached.  

§ Squelch Speed - This is a user selectable response speed.  If the signal value exceeds the threshold 
specified, PSK31 characters will be decoded.  Under good signal conditions, a fast response may be 
best.  Under noisy signal conditions, you may need to select a slower response.  Larger values will 
give a slower response speed.  

§ AFC Limit - An AFC Limit can be selected from 0 to 1000 Hz. The PSK center frequency is 
restricted to plus or minus the AFC limit in Hz.  

§ Sound Card Clock Adjust - This option is used to compensate for sound cards that are off 
frequency.  Increasing the Sound Card Clock Adjust makes the sound card clock faster.  Decreasing it 
will make the sound card clock slower.  

§ Sound Card Devices - Select whether you want to use your preferred or default sound card device.  
If you have more than one sound card, you can select which sound card device you want to use.  

§ TNC PSK31 Hardware Interface Installed – Enables the MFJ PSK31 Hardware Interface, if 
installed with your TNC. 
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CQ, ID and QRT Macros 

 

§ Macro - This is where you type in the macro that will be executed when the CQ, ID or QRT buttons 
are pressed. 

§ CQ - Text to be sent when you call CQ.  

§ ID - Your call sign and other identification you may want to send. 

§ QRT - Your sign off text  
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Edit Macros 

 

A Macro is user-defined text that is associated with a particular keystroke.  This dialog box allows 
you to create macros.  There are 10 global macros for VHF, 10 global macros for HF, and 10 
macros for each HF mode.  Pick a name for the macro and then enter the information in the macro 
text window.  (You can use  <Ctrl-Enter> to insert a carriage return into the macro text).  You 
can create a macro using the user-defined macro variables as shown in the picture below.  The 
name you specify for the new macro will show up in the Macro menu. 
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Edit Call Sign Exchange 

 

This box allows you to edit your call sign and the other station's call sign to be used with the Call 
Exchange hot key. 
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User Defined Macro Variables 

 

These variables can be used in the macros that you create in the Edit Macros Settings.  The macros 
can be created using variable names and when these variables change, the macro changes 
automatically.  Click each setting for a description.  There are five macro variables you can use 
that are not listed.  Three of the macros are taken from your system clock -  {date}, {time} and 
{utctime}.  The {utctime} macro variable shows Greenwich Mean Time.  The other two are 
{xmit} and {rec}.  The {xmit} variable turns the Transmitter on and the {rec} variable turns the 
Transmitter off.  These two variables can only be used in HF macros.  With the release of version 
1.5 of MultiComm Host, another macro variable is available, {sn}, and is used as a serial number 
for contests.  You can use this new macro variable to keep track of the number of contacts you 
make.  For example you could set up a macro in the 'Edit Macro' tab of the Settings screen with 
the following macro: 

This is {mycall} from {qth} you are contact number {sn} 

 

This macro would read as: 

 

This is N4GDO from Florence, AL you are contact number 1. 

 

With the {sn} macro, MultiComm Host will remember the numb er of times you ran the macro and 
will increment the number displayed by 1 each time.  MultiComm Host will remember the number 
that was last used even when you close down the program, so you can take a break from the 
contest to eat.  When you come back the number will be the same as when you left.  To restore the 
number back to zero at the end of the contest or at the beginning of a new one simply go to the 
'User Defined Macro Variables' tab in the Settings window and change the number in the {sn} 
field to 0. 
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HF Edit Menu 
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HF Edit Menu 

 

This is the HF Edit menu.  For more information on each option, click on it. 

 

   

Cut - Use this command to remove the currently 
selected data from the session and put it in the 
clipboard 

Copy - Use this command to copy selected data 
onto the clipboard.   

Paste - Use this command to insert a copy of the 
clipboard contents at the insertion point. 

Clear Screen - Clears the text from the active text 
window. 

Repeat Last Text - Repeats the last text you sent.  
The text will be put into the active chat window. 

Copy To Call Exchange - Allows you to copy 
your contact’s call sign into the call exchange 
buffer.   

Call Exchange  - Takes the call sign you have 
copied with Copy to Call Exchange and appends it 
to the information that was created in the Settings 
for call exchange. 
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HF View Menu 
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HF View Menu 

 

This is the HF View menu.  

  

Toolbar - Use this command to display and hide the Toolbar. 

Status Bar – Use this command to display and hide the Status Bar. 

Wordwrap – Causes text to wrap to the next line when reaching the end 
of the window. 

(Check mark indicates it is being displayed) 

 

 



 175 

Wordwrap Command 

 

Wraps line around to the next line when characters reach the right edge of the screen.  
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HF Mode Menu 
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HF Mode Menu 

 

This is the HF Mode menu.  

  

CW - Sets the current HF mode to CW. 

RTTY - Sets the current HF mode to RTTY. 

ASCII - Sets the current HF mode to ASCII. 

NAVTEX - Sets the current HF mode to 
NAVTEX. 

AMTOR - Sets the current HF mode to AMTOR. 

PACTOR - Sets the current HF mode to 
PACTOR. 

Sync with Log Windows  - Allows MultiComm 
Host to sync with Log Windows™.  Both Log 
Windows and MultiComm Host must be running 
to use this command. 

Sync with Dx4Win - Allows MultiComm Host to 
sync with DX4WIN™.  Both DX4WIN and 
MultiComm Host must be running to use this 
command 
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CW 

 

CW is another name for Morse code.   

 

To make a CW contact you must: 

1) First Open a New HF Window from the File menu. 

2) To change modes: 

a) Select CW from the Mode menu. 

b) Click on the CW button  in the toolbar. 

3) Once you are in the correct mode (notice the mode in the status bar), you need to tune the CW 
signal according to the specifications in your MFJ TNC manual. 

4) When it is tuned correctly, you will start to see the CW characters in the text window. 

5) Now you are ready to reply or call CQ.  There are two ways to accomplish this. 

b) Type text in the chat box and press <Enter>.  Pressing <Enter> turns on transmit.  It 
then transmits the text from the chat box and then switches back to receive 
automatically.  To send a carriage return without turning on the transmitter, press 
<Ctrl-Enter>.  

b) You can also click on the Transmit button  and type your message in the chat box.  
With this, you send one (1) character at a time.  Then you must click the Receive 

button  to receive.  This clears the chat buffer. 

6) Now you are ready to call CQ again or receive CW from another station. 

 

 



 179 

RTTY 

 

To make a RTTY contact you must: 

1) First Open a New HF Window from the File menu. 

2) You need to be in RTTY mode.  To check the current mode, look at the status bar. 

3) There are two ways to change modes: 

a) Select RTTY from the Mode menu. 

b) Click on the RTTY button  in the toolbar. 

4) Once you are in the correct mode (notice the mode in the status bar), you need to tune the 
RTTY signal according to the specifications in your MFJ TNC manual. 

5) When it is tuned correctly, you will start to see the RTTY characters in the text window. 

6) Now you are ready to reply or call CQ.  There are two ways to accomplish this. 

a) Type text in the chat box and press <Enter>.  Pressing <Enter> turns on the transmitter.  
It then transmits the text to the TNC and then switches back to receive automatically. To 
send a carriage return without turning on the transmitter, press <Ctrl-Enter>.  

b) You can also click the Transmit button  and type your message in the chat box.  With 

this, you send one (1) character at a time.  Then you must click the Receive button  to 
receive.  This clears the chat buffer. 

7) Now you are ready to call CQ again or receive RTTY from another station. 
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ASCII 

 

To connect using ASCII: 

1) First Open a New HF Window from the File menu. 

2) To change modes: 

a) Select ASCII from the Mode menu. 

b) Click on the ASCII button  in the toolbar. 

3) Once you are in the correct mode (notice the mode in the status bar), you need to tune to the 
ASCII signal according to the specifications in your MFJ TNC manual. 

4) When it is tuned correctly, you will start to see the ASCII characters in the text window. 

5) Now you are ready to reply or call CQ.  There are two ways to accomplish this. 

a) Type text in the chat box and press <Enter>.  Pressing <Enter> turns the transmitter on.  
It transmits the text to the TNC, and then switches back to receive automatically.  To send 
a carriage return without turning on the transmitter, press <Ctrl-Enter>.  

b) You can also click the Transmit button  and type your message in the chat buffer.  
With this, you send one (1) character at a time.  Then you must click the Receive button 

 to receive.  This clears the chat buffer and turns off the transmitter. 

6) Now you are ready to call CQ again or receive ASCII from another station. 
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NAVTEX 

 

NAVTEX is transmitted with Mode B AMTOR (FEC).  NAVTEX is sent with a unique message 
format to identify the sending station, the type of message, and the message sequence number.  
NAVTEX is a receive-only mode. 

 

To make a NAVTEX contact you must: 

1) First Open a New HF Window from the File menu. 

2) You need to be in NAVTEX mode.  To check the current mode, look at the status bar. 

3) There are two ways to set the mode. 

a) Select NAVTEX from the Mode menu. 

b) Click on the NAVTEX button  in the toolbar. 

4) Once you are in the correct mode (notice the mode in the status bar), you need to tune to the 
NAVTEX signal according to the specifications in your MFJ TNC manual. 
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AMTOR 

 

There are two basic modes for AMTOR operation.  Mode A operation is called ARQ.  ARQ is a 
one-to-one mode, meaning you are allowed to communicate with only one station at a time.  Mode 
B operation is called FEC.  This mode is similar to RTTY.  Unlike ARQ, FEC is a continuous 
broadcast.   

 

To make an AMTOR contact you must: 

1) First Open a New HF Window from the File menu. 

2) You need to be in Listen AMTOR mode.  To check the mode, look at the status bar. 

3) To change modes: 

a) To connect to Mode A: 

i) Select Listen AMTOR mode from the Mode menu. 

ii) Click on the Listen AMTOR button .  Tune to the AMTOR signal according 
to the specifications in your MFJ TNC manual. 

iii) Click on the AMTOR button  if you want to call CQ.  Then click the "T" 
button to turn on the transmitter. 

iv) To link to another station, you need to select Link from the AMTOR menu or 

click the Link button  on the toolbar.  This will bring up a Tor Connect box 
where you need to enter the SELCAL of your contact. 

 

v) To Call CQ: 

(1) Type text in the chat buffer and press <Enter>.  Pressing <Enter> turns on 
the transmitter.  It then transmits the text to the TNC and then switches back 
to receive automatically. To send a carriage return without turning on the 
transmitter, press <Ctrl-Enter>. 

(2) You can also click the Transmit button , and type your message in the 
chat box.  With this you send one (1) character at a time.  Then you must 

click the Receive button  to receive.  This clears the chat buffer. 
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vi) To disconnect, select the Disconnect option from the AMTOR menu or click the 

Disconnect button  on the toolbar. 

b) To connect to mode B: 

i) Select FEC mode from the Mode menu. 

ii) Click on the FEC button  in the toolbar. 

iii) Once you are in the correct mode (notice the mode in the status bar), you need to 
tune to the FEC signal according to the specifications in your MFJ TNC manual. 

iv) When it is tuned correctly, you will start to see the FEC characters in the text 
window. 

v) Now you are ready to reply or call CQ.  There are two ways to accomplish this. 

(1) Type text in the chat box and press <Enter>.  Pressing <Enter> turns on the 
transmitter.  It then transmits the text to the TNC and then switches back to 
receive automatically. To send a carriage return without turning on the 
transmitter, press <Ctrl-Enter>. 

(2) You can also click the Transmit button  in the toolbar and type your 
message in the chat buffer.  With this  you send one (1) character at a time.  

Then you must click the Receive button  to receive.  This clears the chat 
buffer and turns off your transmitter. 

vi) Now you are ready to call CQ again or receive FEC from another station. 
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Listen AMTOR 

 

Listen AMTOR allows you to tune to an ARQ signal without being part of the link.  From Listen 
AMTOR you are able to display the text, but no error correction takes place. 

 

To make a Listen AMTOR contact you must: 

1) First Open a New HF Window from the File menu. 

2) There are two ways to select the mode. 

a) Select AMTOR_Listen from the Mode menu 

b) Click on the Listen AMTOR button  in the toolbar. 

3) Once you are in the correct mode (notice the mode in the status bar), you need to tune to the 
Listen AMTOR signal according to the specifications in your MFJ TNC manual. 

 

This option places the TNC in the Listen AMTOR mode.  The TNC will receive FEC, 
SELFEC, or ARQ signals and will not transmit when in AMTOR_Listen mode.  You can link 

to a station in AMTOR_Listen mode.  Click the Link button  in the toolbar and type in the 
call sign.  MultiComm Host will set the TNC to AMTOR mode to make the connection. 
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FEC 

 

FEC is the acronym for Forward Error Correction.  This is Mode B in AMTOR. 

 

To make a FEC contact you must: 

1) First Open a New HF Window from the File menu. 

2) To change modes: 

a) Select FEC from the Mode menu. 

b) Click on the FEC button  in the toolbar. 

3) Once you are in the correct mode (notice the mode in the status bar) you need to tune to the 
FEC signal according to the specifications in your MFJ TNC manual. 

4) When it is tuned correctly you will start to see the FEC characters in the text window. 

5) Now you are ready to reply or call CQ.  There are two ways to accomplish this. 

a) Type text in the chat box and press <Enter>.  Pressing <Enter> turns on the transmitter.  
It then transmits the text to the TNC and then switches back to receive automatically. To 
send a carriage return without turning on the transmitter, press <Ctrl-Enter>. 

b) You can also click the Transmit button  in the toolbar and type your message in the 
chat buffer.  With this you send one (1) character at a time.  Then you must click the 

Receive button  to receive.  This clears the chat buffer. 

6) Now you are ready to Call CQ again or receive FEC from another station. 
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PACTOR 

 

PACTOR uses a handshaking system to send data.  An ACK (acknowledgment) is sent when data 
is received intact and a NAK is sent for corrupted data. 

 

To make a PACTOR contact you must: 

1) First Open a New HF Window from the File menu. 

2) You need to be in PACTOR mode.  To check the current mode, look at the status bar. 

3) There are two ways to change modes: 

a) Select PACTOR from the Mode menu. 

b) Click on the PACTOR button  in the toolbar. 

4) Once you are in the correct mode (notice the mode in the status bar), you need to tune to the 
PACTOR signal according to the specifications in your MFJ TNC manual. 

5) When it is tuned correctly, you will start to see the PACTOR characters in the text window. 

6) Now you are ready to request a link or call CQ. 

7) To connect, select the PACTOR Connect option from the PACTOR Menu and type in the call 
sign you want to connect to.  Click the Connect button.  To change from IRS to ISS use the 
appropriate buttons. 

8) To call CQ you need to click the Transmit button  in the toolbar and type your message in 
the chat buffer.  This will send one (1) character at a time.  Then you must click the Receive 

button  to receive.  This clears the chat buffer. 

9) To disconnect select PACTOR Disconnect. 
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HF Format Menu 
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HF File Transfer Menu 
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HF File Transfer Menu 

 

This is the HF File Transfer menu. 

  

Send ASCII - Sends an ASCII file with no protocol. 

Abort ASCII Transfer - Stops an ASCII file transfer. 
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HF TNC Menu 
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HF TNC Menu 

 

This is the HF TNC menu.   

 

  

Commands  - These are some commands 
available in HF for the TNC. 

Xmit On - Turns the transmitter on.  

Xmit Off - Turns the transmitter off. 

Pause Xmit - Returns to Receive mode 
immediately in FEC. 

Kill Xmit Buffer - This stops the transmission 
and clears out the TNC transmit buffer. 

Transmit By – Allows you to choose to transmit 
text after each character, transmit after each word 
or space, or transmit after pressing <Enter>. 
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Transmit On 

 

Turns the transmitter on in a non-linked mode.  There are three ways to turn Transmit on: 

• Click on the Transmit button  in the toolbar. 

• Press F4. 

• Select “Transmit On” from the TNC menu. 

 

Shortcuts 

 

     Toolbar:    

     Hotkey:   F4 
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Transmit Off 

 

Turns the transmitter off in a non-linked mode.  There are three ways to turn Transmit off: 

• Click on the Receive button  in the toolbar to change from Transmit to Receive. 

• Press F4 or F5. 

• Select “Transmit Off” from the TNC menu. 

 

Shortcuts 

 

     Toolbar:   

     Hotkey:   F4 or F5 
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Pause Xmit 

 

Pause Transmit Option.  Returns to Receive mode immediately in FEC.  Characters still in the 
TNC transmit buffer will remain there. 
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Kill Xmit Buffer 

 

Kill Transmit Buffer.  This stops the transmission and clears out the TNC transmit buffer. 
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Transmit By 

 

Allows you to choose to transmit text after each character, to transmit after each word or space, or 
to transmit after pressing <Enter>.  You can use <Ctrl-Enter> to send a Carriage Return without 
transmitting the text.  
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CW Menu 
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CW Options 

 

These are the CW commands.  

  

Lock CW Speed - Lock CW Speed causes the TNC to lock 
the CW transmit speed to the speed of the CW signal being 
received. 
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Lock CW Speed 

 

Lock CW Speed causes the TNC to lock the CW transmit speed to the speed of the CW signal 
being received. 
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RTTY Menu 
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RTTY Options 

 

This is the RTTY pull down menu.  

  

Baud Rate - This sets the transmit and receive 
speeds for RTTY. 

Shift – Allows you to select a frequency shift of 
170, 425, or 850 Hz.  
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Baud Rate 

 

This sets the baud rate for each non-packet mode. 

 

For RTTY and ASCII you have these options: from 45-300 baud rate. 

For PACTOR you have these options: 100, 200, and Auto.     

For AMTOR you have these options: 100, 200, 300, and Auto. 
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RTTY Shift 

 

Allows you to select a frequency shift of 170, 425, or 850 Hz.   
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ASCII Menu 
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ASCII Options 

 

These are the ASCII commands.  

  

Baud Rate - This sets the transmit and receive 
speeds for ASCII 

Shift – Allows you to select a frequency shift of 
170, 425, or 850 Hz.   
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ASCII Shift 

 

Allows you to select a frequency shift of 170, 425, or 850 Hz.   
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NAVTEX Menu 
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NAVTEX Menu 

 

These are the NAVTEX Commands.  

   

 

Shift – Allows you to select a frequency shift of 
170, 425, or 850 Hz.   
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Navtex Shift 

 

Allows you to select a frequency shift of 170, 425, or 850 Hz.   
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Amtor Menu 
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AMTOR Options 

 

This is a list of the AMTOR commands.  

 
  

 

Link - Links to an AMTOR station. 

Disconnect - Disconnects from an 
AMTOR station. 

Shift - Allows you to select a frequency 
shift of 170, 425, or 850 Hz.   

Get WRU - Who Are You text.  Gets 
personal information from the TNC. 

AMTOR Listen – Switches to Listen 
AMTOR mode. 

SELCALL - SELCALL is similar to Mode 
B FEC, except the broadcasting station can 
select one station or a group of stations to 
receive the transmission.  
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AMTOR Link 

 

The AMTOR Connect command connects to a packet station depending on the call sign entered. 
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AMTOR Disconnect 

 

The AMTOR Disconnect command disconnects from a packet station. 
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AMTOR Shift 

 

Allows you to select a frequency shift of 170, 425, or 850 Hz.   
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Get WRU 

 

Who Are You text.  Gets personal information from the other TNC. 
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AMTOR Listen 

 

To connect using Listen AMTOR: 

1) First Open a New HF Window from the File menu. 

2) There are two ways to select the mode. 

a) Select AMTOR_Listen from the Mode menu. 

b) Click on the AMTOR_Listen button  in the toolbar. 

3) Once you are in the correct mode (notice the mode in the status bar), you need to tune the 
Listen AMTOR signal according to the specifications in your MFJ TNC manual. 

 

This option places the TNC in the Listen AMTOR mode.  The TNC will receive FEC, 
SELFEC, or ARQ signals and then will not transmit when in AMTOR_Listen mode.  You 

can link to a station in AMTOR_Listen mode.  Click the Link button  and type in the 
call sign.  MultiComm Host will set the TNC to AMTOR standby mode to make the 
connection. 

 

Listen AMTOR allows you to tune to an ARQ without being part of the link.  From Listen 
AMTOR you are able to display the text, but no error correction takes place. 

 

 



 217 

SELCALL (Mode I) 

 

SELCALL is similar to Mode B FEC, except the broadcasting station can select one station or a 
group of stations to receive the transmission. You will be presented with a window requiring you 
to enter the SELCAL.  Enter the SELCAL and click the OK button.  This will turn the transmitter 
on and send the SELCAL as the preamble to a transmission, followed by any text you type into the 

chat window.  To return to Receive mode, click on the Receive button  or press F5.  At this 
time, you will only be able to receive SELFEC transmission. To receive any FEC transmission, 
press F10 and type “auto-start off” (without the quotes).  To send another SELFEC broadcast, 
select the SELFEC menu option. 
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Pactor Menu 
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PACTOR Options 

 

These are the PACTOR commands.  

   

 

PACTOR Connect - The PACTOR Connect 
command connects to a packet station depending 
on the call sign entered.  

PACTOR Disconnect - The PACTOR 
Disconnect command disconnects from a packet 
station. 

Abort PACTOR Link - Aborts a link in progress. 

PACTOR Shift  - Allows you to select a 
frequency shift of 170, 425, or 850 Hz.   

PACTOR Listen - Selecting this menu option 
puts the TNC in PACTOR Listen mode. 
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PACTOR Connect 

 

The PACTOR Connect command connects to a packet station depending on the call sign entered. 
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PACTOR Disconnect 

 

The PACTOR Disconnect command disconnects from a packet station. 
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Abort PACTOR Link 

 

Choose this option during the link phasing process if you wish to abort the link.  Once chosen, the 
current link attempt will be aborted. 
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PACTOR Shift 

 

Allows you to select a frequency shift of 170, 425, or 850 Hz. 
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PACTOR Listen 

 

Selecting this menu option puts the TNC in PACTOR Listen mode.  This mode will allow you to 
copy FEC or ARQ (Linked) PACTOR stations, but you cannot transmit from this mode.  You can 

link to a station by clicking on the Link button , which returns to PACTOR mode.  To exit 
PACTOR Listen mode, click “PACTOR Listen” again on the PACTOR menu to remove the check 

mark or click on the PACTOR button  again. 
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Lookup Menu 
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Macros Menu 
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PSK31 Control Panel 
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PSK31 Control Panel 

 

When you start PSK31, the PSK31 Control Panel will come up.  The Control Panel has controls 
used to tune a PSK31 signal as well as graphical displays for finding and tuning PSK31 signals.   
The Control Panel contains Spectrum, Waterfall, Input, and Data Sync views of the signals.  Click 
on the appropriate tab to switch between the views.  Controls are located to the left and to the 
bottom of the Control Panel.  To send text or to view received text, go to the Main HF View 
window in MultiComm Host.  For general information on PSK31 in MultiComm Host, see the 
PSK31 Information and PSK31 Setup sections of this help file.  

 

  

RX Freq - Receive Frequency.  Allows you to type in or select a receive 
frequency.  The new frequency takes effect after the mouse cursor is 
clicked on another part of the Control Panel.  

AFC - Automatic Frequency Control.  Selecting this option allows 
PSK31 to automatically tune to the nearest signal.  To tune a frequency, 
click your left mouse button near a signal and AFC will tune to the center 
frequency of the nearest signal.  If AFC doesn’t lock correctly on the 
center frequency, there may be poor propagation or you may be receiving 
a poor transmitting station.  In this case, you will need to turn off AFC.  

TX Freq - Transmit Frequency.  Allows you to type in or select a 
transmit frequency.  The new frequency takes effect after the mouse 
cursor is clicked on another part of the Control Panel.  

Net - Forces transmitter to use the current Receiver frequency. If both 
stations use it, they will tend to move across the band together.  If neither 
station uses it, the stations may drift apart.  If only one station uses it, the 
station not using Net becomes the "Master".   

BPSK - Binary PSK.  BPSK is the most commonly used mode but lacks 
forward error correction.  BPSK is indicated in the Vector Display as two 
vertical lines.  

QPSK - Quadrature PSK.  QPSK has forward error correction but can be 
harder to tune.  It is indicated in the Vector Display as two vertical and 
two horizontal sets of lines. QPSK is sensitive to sideband so you must 
select either upper sideband (usb) or lower sideband (lsb).  

SQ - Squelch Control.  This bar graph sets the signal quality threshold to 
reduce reception of garbage characters.  It acts by inhibiting reception 
until the signal exceeds a specified level.  The vertical bar at the bottom 
will get longer as the signal quality increases.  A small blue horizontal bar 
indicates the current squelch threshold and can be moved with the mouse 
to the desired threshold.  Signals must exceed this threshold for characters 
to be displayed.  The color of the bar is gray when it is below the squelch 
threshold bar and changes to yellow when it increases above the squelch 
threshold bar.  
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Slow - This option smoothes out the spectral display.  However, fast changing signals may be lost 
during smoothing.  

Zoom - Zoom allows you to look at smaller or larger areas of the display.  The display zooms 
around the current frequency cursor position.   The lowest displayed frequency is shown to the left 
of the display.  The highest frequency is shown to the right of the display.  Click the arrow buttons 
to zoom in or out.  
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PSK31 Spectrum Display 

 

The PSK31 Spectrum Display graphs the incoming signal with frequency on the horizontal axis 
and amplitude on the vertical axis.  The gray horizontal grid lines represent 10 dB gradient steps in 
amplitude. The dashed vertical yellow line represents the current PSK31 receiver center 
frequency.  To automatically tune a frequency, put a check mark beside "AFC” on the left side of 
the Control Panel.  Then click the left mouse button on a signal.  The dashed vertical line will 
move to the center frequency of the nearest signal.  The Vector Display in the upper left corner 
can be used to help find PSK signal.  Two vertical lines going in opposite directions from the 
center will indicate a BPSK signal.  A QPSK signal will be indicated by two vertical and two 
horizontal lines from the center.  Clicking the right mouse button on the display will also change 
the receiver frequency and "rewind" the audio back 25 seconds.  
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PSK31 Waterfall Display 

 

The Waterfall Display is similar to the Spectrum Display.  A Spectrum is displayed at the top.  
Below that is the Waterfall.  In the Waterfall Display, the horizontal axis is Frequency and the 
vertical axis is Time.  Horizontal lines are added to the top of the Waterfall Display, pushing older 
horizontal lines down one notch.  The brightness and color of a horizontal line indicate amplitude.  
As the amplitude at a particular frequency becomes stronger, that area of the line will become 
brighter and the color will shift from blue to cyan to yellow to white.  As newer lines are added to 
the top of the graph, you can see a "history" of the signal.  A dashed vertical yellow line indicates 
the frequency where the receiver is currently centered.  Your mouse cursor can be used to move 
the center frequency by clicking the left mouse button on a signal.  Clicking the right mouse 
button will also move the center frequency and "rewind" the audio 25 seconds. The Vector 
Display in the lower left corner can be used to help find PSK31 signals. Two vertical lines going 
in opposite directions from the center will indicate a BPSK signal.  A QPSK signal will be 
indicated by two vertical and two horizontal lines from the center. 
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PSK31 Input Display 

 

The Input Display shows the raw input signal with Amplitude on the vertical axis and Time on the 
horizontal axis.   The Input Display is primarily used to adjust the receiver and sound card input 
level.  The display changes from green to red when the input level becomes too high.   
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PSK31 Data Sync Display 

 

The Data Sync Display shows a histogram of the internal signal to determine the center of the 
received bit.  An elongated line marks the peak of the histogram.  The Data Sync Display can be 
used to determine if the incoming signals or the user's sound card is off frequency.  
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HF Packet Session 
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HF Packet 
 

If you want to connect to HF packet, there are several things you will need to know to help you 
out.  When using a MFJ TNC, you must remember that this TNC has two radio ports but only one 
radio port can be used at a time.  Because of this, when you wish to start a HF packet session, you 
must do a couple things first.  First you must make sure that the HF non-packet session window of 
MultiComm Host is closed.  Secondly go to the File menu, choose Settings and then click on the 
Communications tab at the top of the window that appears.  As you can see in this picture, you 
will see a section on the bottom of this screen that allows you to select HF or VHF Packet mode 
for the next session.   

  

 

Once you have selected the mode for HF packet, you will have to restart MultiComm Host for the 
change to take effect.  Once the HF session is open, you use the HF Packet window in the same 
way as the VHF Packet. 
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Logging Programs 
 

Starting with MultiComm Host Version 1.5, you can sync a MultiComm Host session window 
with a Log Windows session or a DX4WIN session.  

 

Synching with a logging program can be very useful during contests and when saving QSOs.  
Using a logging program like DX4WIN or Log Windows helps to connect and navigate a DX 
Cluster. 
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Log Windows 
 

MultiComm Host provides a TNC interface for Log Windows version 2.0 and higher.  Data being 
received or echoed by the TNC can be sent to Log Windows.  Likewise data typed in the Log 
Windows transmit window can be sent to the MultiComm Host window.  MultiComm Host acts as 
a data engine for Log Windows.  One of MultiComm Host’s user port windows can be redirected 
to the Log Windows TNC window, allowing full two-way communications between Log 
Windows and a TNC through MultiComm Host.  For example, if you are using a dual port TNC 
and MultiComm Host you may,  

1) Redirect TNC Port 2, which is VHF Packet for use with Log Windows. 

2) Use TNC Port 1 for other HF digital modes. 

As you can see, you may enjoy the benefits of true dual port operating while sharing the power of 
MultiComm Host and Log Windows.  Log Windows 2.0 or greater is required.  All MultiComm 
Host functions are still enabled while communicating with Log Windows. 

 

Synchronizing MultiComm Host with Log Windows 

 

MultiComm Host must first become aware that Log Windows is running.  To do this: 

1) Start both programs. 

2) Either click the Log Windows button  in the toolbar or select the Mode menu and choose 
Sync with Logging Program, and then choose Log Windows. 

 

Once you have Synched MultiComm Host and Log Windows, simply minimize MultiComm 
Host and you can communicate with the TNC using Log Windows.  For more information on 
using Log Windows, consult the Log Windows program documentation. 
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DX4WIN 
 

In order to use DX4WIN with MultiComm Host you must first set up DX4WIN to recognize 
MultiComm Host.   

 

To setup DX4WIN simply: 

1) Open DX4WIN.  

2) Click on the File menu at the top of the window. 

3) Choose Preferences. 

4) A window that says 'Setup Parameters' should appear.  On the right side of the window you 
should see about 16 tabs.  Choose the tab that says ‘Packet1’ 

5) At the top of the window under the TNC interface section type the following in: 

c) Type : Regular 

d) COM Port: Msg 

e) Message Handshake: CSS TNC PROGRAM|Multicomm Host       

Important: MESSAGE HANDSHAKE MUST BE TYPED EXACTLY AS YOU SEE IT HERE!  

 

In the above message the | character before MultiComm Host is called a 'Pipe' and is located above 
the \ key on your keyboard (on the keyboard it looks like a stretched out colon). 
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6) Click on the File menu and choose Save Changes. 

 

Now DX4WIN is ready for use with MultiComm Host.  Simply load MultiComm Host and 

DX4WIN at the same time and click on either the DX4WIN button , or click on the Mode 
menu at the top of the MultiComm Host window and choose Sync with Logging Program and then 
choose DX4WIN. 
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Getting Started with Rig Control 
 

Starting in Version 1.5 of MultiComm Host, a basic form of rig control has been included to make 
your life easier while surfing the airwaves and using MultiComm Host.  The design of the Rig 
control option in MultiComm Host was intended to be intuitive and second nature, so you will no 
longer have to keep going around your ham shack from the computer to the radio to change 
frequencies and then back to the computer again.  Hey, if you had a long enough serial cord and a 
laptop, you could even make contacts while you're watching your favorite shows in the living 
room! 

 

Before we get started, you will need to make sure you have all the things required to use the Rig 
Control feature.   

1) A transceiver on the compatibility list below.  (This is just a preliminary list.  Newer versions 
of rig control will support more transceivers.) 

2) A RS-232 Interface for Rig Control that is compatible with your transceiver. 

3) A computer with two open serial ports (one for the TNC and one for the RS-232 interface.). 

 

NOTE:  THE RIG CONTROL SOFTWARE IS IN PREVIEW.  IF YOU EXPERIENCE ANY 
PROBLEMS WITH IT PLEASE COMMUNICATE THEM TO rigcontrol@cssincorp.com.  

 

Transceiver Compatibility list 

 

Manufacturer  Model  Manufacturer  Model 

 

Alinco:   DX-77  Ten-TEC:  535 

ICOM:   IC-707  Ten-TEC:  536 

ICOM:   IC-725  Ten-TEC:  563 

ICOM:   IC-726  Ten-TEC:  564 

ICOM:   IC-728  Ten-TEC:  OMNI-VI 

ICOM:   IC-729  Yaesu   FT-1000 

ICOM:   IC-735  Yaesu   FT-757GX 

ICOM:   IC-736  Yaesu   FT-840 

ICOM:   IC-737  Yaesu   FT-900 
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ICOM:   IC-738  Yaesu   FT-990   

ICOM:   IC-751A 

ICOM:   IC-756 

ICOM:   IC-761 

ICOM:   IC-765 

ICOM:   IC-781 

Kenwood:  TS-450S 

Kenwood:  TS-50S 

Kenwood:  TS-690S 

Kenwood:  TS-850 

Kenwood:  TS-950S 

 

See the Setting up Rig Control section of this help file for more information on setup. 
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Setting Up Rig Control 
 

Now that you've gotten everything you need to take advantage of Rig Control, all you have to do 
is plug the RS-232 interface into your radio and then plug the other end of the RS-232 interface 
into your open serial port.  Once the hardware is set up, just load the Rig Control program.  The 
first time you load the Rig Control program you should see a screen telling you that you need to 
configure it for your computer and radio.  The screen should look like this: 

 

  

 

Once you see this window just click on the 'OK' button to proceed to the next screen. 

 

The next window you will see will be the Radio Setup screen.  If you ever have to change a setting 
this is where you will do so. 
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The first thing to do is to select the COM port where the RS-232 interface for your radio is 
connected.  For most people it will be either COM 1 or COM 2 since these are usually the 2 
external serial ports on a computer.  Be warned though that people using a serial mouse will either 
have to have a PS/2 mouse or obtain an additional external serial port. 

 

The second thing you will need to do on the Settings screen is to select the baud rate of the serial 
port the radio is on.  The baud rate depends on what the interface for the radio is set for.  The 
default baud rates for the radios are: 

 

RADIO   BAUD 

Kenwood 4800 

ICOM  1200 

Yaesu  4800 

Alinco  9600 

Ten-Tec  1200 
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The baud rates may be changed if so desired.  Please consult your radio's user manual for 
information on how to change the baud rate on your radio.  See the Using Rig Control section of 
this help file for more information on using the controls in the Rig Control window. 
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Using Rig Control 
 

Now that you've got the Rig Control set up, you can have lots of fun without having to keep 
reaching over and tuning the radio manually.  You should now see this screen when you run Rig 
Control.   

  

 

At the top of the window you should see a large digital display.  This is the frequency to which the 
radio is set.  If you look at your radio when this window pops up you should see it is set to this 
frequency.   

 

There are several ways to tune the radio.  For general tuning you can use the knob to tune quickly 
to a different frequency.  This lets you tune faster but it is harder to fine tune to a specific 
frequency.  Once you get to the general area that you want, simply use the up and down arrows 
found below the frequency display.   

 

If you're interested in changing bands then you can click the '500 kHz UP' or the '500 kHz DOWN' 
button to raise or lower the frequency by 500 kHz.   

 

The Modes simply let you change the radio between Upper Side Band (USB), Lower Side Band 
(LSB), CW, AM, or FM.   
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DLOCK - Locks the dial so you cannot tune with the dial on the radio.  You can still tune with the 
Rig Control software though.   

 

TUNE - Sets your Antenna Tuner. 

 

UP and DOWN - Depending on the radio these buttons will either switch up and down a band or 
change the frequency up or down 100 kHz.  

 

CLAR - This is the clarifier.  When this button is clicked, you can tune and change bands to 
change the receiving frequency without changing the transmitting frequency.  When the button is 
depressed, the receiving frequency changes back to the original frequency. 

 

Underneath the Meter at the upper-right hand corner of the Rig Control window you will notice a 
group of buttons.  These buttons are VFO A/B, SPLIT, MEMO, VFO->M, AND M->VFO. 

• VFO A/B - Pressing this button causes the frequency data in the VFO A and VFO B 
registers to be exchanged.  If this button is pushed again then the frequency data will be 
exchanged again, returning it to its original frequency. 

• SPLIT - Pressing this button enables split frequency operation, letting you switch from 
simplex to duplex operation.  The frequency shown will be the receiving frequency until you 
key the mike and then the frequency shown will be changed to the transmitting frequency. 

• VFO->M - This button writes the frequency data from the selected VFO into the last 
selected memory channel. 

• M->VFO - This button writes the frequency data from the last selected memory channel into 
the last selected VFO.  The memory data remains unchanged in the memory, but previous 
data in the VFO is overwritten. 

 

NOTE: NOT ALL RADIOS WILL SUPPORT ALL OF THESE FUNCTIONS.  FOR MORE 
INFORMATION ON YOUR RADIO'S FUNCTIONS PLEASE CONSULT YOUR RADIO 
MANUAL. 

 

When you are done using the Rig Control simply click the OK button at the bottom of the window 
to close it.  To change the settings for the Rig Control (i.e., baud rate or COM port) click the Setup 
button.  This will take you back to the same setup screen you saw when you first set up Rig 
Control.  For more information on setting up Rig Control or changing the settings please see the 
Setting up Rig Control section of this help file. 
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Slow Scan TV 
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SSTV Window 
MultiComm Host allows you to send and receive Slow Scan TV pictures over radio using the 
Slow Scan TV capability of your MFJ TNC.  To start Slow Scan TV, click on the File menu on 
the main MultiComm Host window and select “SSTV Modes”.  This will open a Slow Scan TV 
window similar to the one below.  
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SSTV Toolbar 
 

This is the SSTV Toolbar.  

  

 

These are the buttons on the SSTV Toolbar 

  Starts Scottie 1 mode 

  Starts Scottie 2 mode 

  Starts Martin 1 mode 

  Starts Martin 2 mode 

  Starts Robot Black and White 8 mode 

  Starts Robot Black and White 16 mode 

  Starts Robot Black and White 32 mode 

  Starts Robot Color 72 mode 

   Starts Wrasse SC2-180 mode 

  Pause Slow Scan 

  Resets Slow Scan parameters 

  Sets AutoSync 

  Sets Slow Scan to Free Running 

  VIS 
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SSTV File Menu 
 

  

Save  – Saves a copy of the SSTV pictures to your 
disk drive 

Exit – Ends your SSTV session and closes the 
SSTV window 
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SSTV Edit Menu 
 

  

Copy – Copies the selected image to the Windows 
clipboard 
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SSTV Mode Menu 
 

  

Scottie 1  – This is a RGB color mode with a 
transmission time of 110 seconds and 240 useable 
scan lines.  Top 16 lines are gray scale.  

Scottie 2  – This is a RGB color mode with a 
transmission time of 71 seconds and 240 useable 
scan lines.   Top 16 lines are gray scale.  

Martin 1 – This is a RGB color mode with a 
transmission time of 114 seconds and 240 useable 
scan lines.  Top 16 lines are gray scale.  

Martin 2 – This is a RGB color mode with a 
transmission time of 58 seconds and 240 useable 
scan lines.  Top 16 lines are gray scale.  

Robot BW 8 – This is a simulated black and white 
mode where green is sent to simulate black and 
white.  Transmission time is 8 seconds with 120 
scan lines. 

Robot BW 12 – This is a simulated black and white 
mode where green is sent to simulate black and 
white.  Transmission time is 12 seconds with 120 
scan lines.  

Robot BW 24 – This is a simulated black and white 
mode where green is sent to simulate black and 
white. Transmission time is 24 seconds with 240 
scan lines.  

Robot CO 72 – This is a color mode with a 
transmission time of 72 seconds and 240 scan lines.  

Wrasse SC2-180 – RBG color mode with a 
transmission time of 180 seconds and 256 scan 
lines. 
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SSTV Slant Menu 
 

  

Adjust Left – If picture is slanted toward the right, 
this command will adjust it to the left. 

Adjust Right – If picture is slanted toward the left, 
this command will adjust it to the right.  
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SSTV Autosync Menu 
 

  

AutoSync picture – Synchronize the picture 
automatically 

Free Running Mode – Receive picture without 
automatic synchronization 
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Troubleshooting 
 

If you were unable to establish communications with your TNC using MultiComm Host, use the 
terminal program titled HyperTerminal under the Accessories menu in Windows to determine 
whether or not your TNC is talking to the serial port.  Once the TNC is operational with 
HyperTerminal, you can go back and troubleshoot your settings in MultiComm Host.  If you 
choose to use HyperTerminal, you will have to set up a program name, the COM port, and baud 
rate for your TNC.  Bring up HyperTerminal by clicking on Start, Programs, Accessories, and 
then select HyperTerminal.  If you can’t find HyperTerminal, it may be located under the 
Communications menu or you may need to install it from your Windows CD.  

It will initially ask you for a name (this is a name of the configuration you will make to test your 
TNC).  Enter a name such as TEST and click on OK.  Next select the COM Port (e.g. COM 1) 
where your TNC is attached and click OK again.  Then select 9600 as your terminal baud rate 
and click the OK button.  NOTE: These are the only parameters you will need to enter or 
change.  Then press <Enter>. 

At this point you may see the command prompt, which means that your TNC is in Terminal 
Mode, the right serial port and baud rate has been selected, and you are able to communicate 
with it.  You may see a few characters including S00, which means the TNC is responding in 
Host Mode.  If you don't see anything at this point, turn the TNC off and then back on.  If you 
now see several characters including S00, you are in Host Mode, indicating that the TNC is 
working. 

If only “garbage-like” characters are displayed, the right serial port has been selected, but the 
baud rate that was selected is not correct.  Return to the Settings screen and select a different 
baud rate. 

If nothing is displayed when the TNC is turned off and back on, the wrong serial port may have 
been selected.  Return to the Settings screen, and try a different serial port selection. 

Make sure the COM port selected is working correctly.  If HyperTerminal works OK to 
communicate through the selected COM port to the TNC, MultiComm Host should also work. 

If HyperTerminal cannot communicate with the TNC, make sure the serial cable is connected 
properly and the TNC is turned on. 

Make sure the serial port that was selected is not one that is already in use by another device 
such as a mouse or a modem. Windows manages the COM port for these types of devices and 
will not allow proper operation of a TNC and MultiComm Host. 

 

Other errors: 

• Application Errors are cause by a 'point gone astray'.  Many times, this could mean 
bad memory, a bad spot on the hard disk or Windows may be in some unknown state.  
When this happens, make sure your 'TEMP' directory on the hard disk has been cleaned 
out (usually C:\Windows\Temp in Windows 95/98/Me) and run ScanDisk.  Details on how 
to do this are in the Windows online help. 
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• Getting an Error during startup.  If you get any of the startup errors that are documented 
elsewhere in this help (MON001, STAMP001, etc.), that normally means there is a 
communication problem between MultiComm Host and your TNC.  Make sure your COM 
port and baud rate in MultiComm Host match that for your TNC.  Also make sure the 
COM port for your TNC has no IRQ conflicts. 

• Scrolling text on the screen is erratic or letters appear 'behind' the splitter bar.  This 
may happen with some video cards with certain fonts.  To fix it, adjust the size of the 
splitter windows by moving the splitter bar up and down to the size you want.  MultiComm 
Host will then save that information. 

• If you cannot see the extended ASCII characters (i.e. box characters appear) on the 
screen, pick a font (such as the "Video Terminal Screen" font) that supports the OEM 
character set.  In the next release, we will be providing you with access to a Symbol font 
that supports this. 

 

Some Error Messages that may occur during startup: 

• NU01 - Error, trying new user Mode.  This message means all attempts to communicate 
with the TNC have failed. 

• MYCALL01 - TNC didn’t return MYCALL status after MultiComm Host sent the 
MYCALL <Call Sign> command. 

• MYCALL02 -TNC didn’t return MYCALL status after MultiComm Host sent the 
MYCALL <Call Sign> command after finding the MYCALL didn't match the Call Sign in 
the MultiComm Host .INI file 

• MON01 - TNC didn’t return MONITOR status after MultiComm Host sent the 
MONITOR ON command 

• MCOM01 -TNC didn’t return MCOM status after MultiComm Host sent the MCOM ON 
command 

• MCON01 -TNC didn’t return MCON status after MultiComm Host sent the MCON ON 
command 

• STAMP01 -TNC didn’t return CSTAMP status after MultiComm Host sent the CSTAMP 
ON command 

• XECH001 -TNC didn’t return XMITECHO status after MultiComm Host sent the 
XMITECHO ON command 

• STA001 - TNC didn’t return STATUS status after MultiComm Host sent the STATUS 
command 
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Technical Support 
 

If you need more information on Windows, please consult Windows Help by clicking on the 
Windows Start button and then selecting Help. 

 

You can also check our web site for information.  Our web site is 
http://www.cssincorp.com/multicommhost. 

Also check out http://www.mfjenterprises.com   

 

For problems with the MultiComm Host documentation, send an email to 
docmaster@cssincorp.com  

 

Support is provided via Phone at (256) 381-6135 and via E-mail at support@cssincorp.com  

 

If you need more information on your TNC, please consult your MFJ TNC Owners Manual. 
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